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Manual Configuration

The following user manuals are enclosed with the product.

stp Read this first

Opening the box and installing the printer
Set-up Guide

This guide uses illustrations to explain the
methods from opening the box to installation.
For the advanced setup guide, see the "Basic".

Preparing the printer to print
Basic (This manual)

This guide describes the precautions for safe
use of the device. Make sure to read before use.
Further, basic uses from the device installation
methods to initial printing are also explained.
The device functions are described in the
appendix.

stp Read these guides as necessary

/_1°L

+ E-format

Try using various functions
Advanced

This guide explains the various paper print methods
and how to use useful functions. Read to optimize the
printing environment or to adjust the color, etc., using
the enclosed utility software.

Further, this guide also explains the items that can be
set from the control panel, and the network settings.

Read for any points that are not understood, or for maintenance
Troubleshooting/Daily
ETNCHELRTICREELTTE]L

This manual explains the procedures for paper jams, and
troubleshooting method if an error message is displayed. This
manual also explains daily maintenance such as now to replace
consumables and maintenance units, and cleaning, etc.

Using SP1360W/SP1360S
Separate Volume Spot Color Guide

This guide explains how to set up the Spot

Color kit and check the printer drivers, and
how to print using Spot Color. Make sure to
read before use.

- Checking the product

- Parts nomenclature and functions

- Using the device to its fullest

- Installing the device

« Turning ON and OFF the power supply

« Test printing using the printer only

- Connecting to a PC

- Paper

- Printing

- Paper ejection

- Setting Power Save mode

« Setting auto power OFF

- Checking the print quantity,
consumables, remaining maintenance
unit quantity, and remaining service life

- Cancelling a print job

- Adding printers using LPD protocols
(TCP/IP)

- Table of control panel menu items

- Basic Windows procedures

- Printer specifications

« Useful print functions

- Adjusting the color

- Using utility software

- Network settings

- Checking and changing printer settings
using the control panel

- Troubleshooting

- Maintenance

- Consumables, maintenance products,
options, color management server,
etc.

- Setting the Spot Color kit

- Control panel explanation

- Checking the printer drivers

- Table of printer driver functions

- Printing on color paper

- Printing on transparent film

- Specifying and printing Spot Color
toner using the applications

« Fine-tuning white

- Switching Spot Color kits



Reading the Manual

Symbols

(! Note)

® These are cautions and restrictions for the correct operation of the device. Make sure to read to avoid misoperation.

® Knowledge of the information before using the device is useful and can act as a reference. Reading is recommended.

Reference

® These are the reference pages. Read to learn detailed information and relevant information.

/\ WARNING

® Mishandling due to ignoring this display may cause death or serious injury.

/\ CAUTION

® Mishandling due to ignoring this display may cause personal injury.

Keys, Buttons, and Symbols

This chapter described the following keys, buttons, and symbols.

Inscription Explanation
® The control panel buttons and 10-key pad are described below.

E.g.:
-} [OK] button ® -} [BACK] button

o= [Fn] key © =P [CLEAR] key

[ 1 button/key

® Indicates your PC keyboard.

[ ] ® Describes the menu name on the liquid crystal panel.
® Describes the PC menus, windows, and dialog box nhames.

® Describes the messages and input text displayed in the liquid crystal
" " panel.

® Describes the file and screen names on the PC.

® Describes the reference title.

> Describes the menu level of the device or PC.




ges of the control panel and PC used
SP1360 model unless otherwise specified. herein are examples. The images may differ
from actual products and screens.

The device illustrations used herein show the The ima

Illustrations may differ from the actual product.

Functions 1/2 Page
n Configuration
Print Information
a Print Secure Job

a Menus
B E|Admin Setup
B E' Print Statistics

O Use Online button to return to standby screen...




The following inscriptions are used in this manual.

® SP1360 — SP1360
® SP1360W — SP1360W
® SP1360S — SP1360S

® Microsoft® Windows® 7 64-bit Edition operating system — Windows 7 (64bit version)
® Microsoft® Windows® 7 operating system — Windows 7

® Mac OS X10.3.9 or later — Mac OS X

The manuals enclosed with the printer use as examples Windows 7 in the case of Windows, and OS X
10.8 in the case of Mac OS X unless otherwise specified.

Depending on the OS and model used, descriptions in this manual may differ.






About the Product Warranty

Every effort has been made to ensure that the information in this document is complete, accurate,
and up-to-date. The manufacturer assumes no responsibility for the results of errors beyond its
control. The manufacturer also cannot guarantee that changes in software and equipment made by
other manufacturers and referred to in this guide will not affect the applicability of the information
in it. Mention of software products manufactured by other companies does not necessarily constitute
endorsement by the manufacturer.

While all reasonable efforts have been made to make this document as accurate and helpful as possible,
we make no warranty of any kind, expressed or implied, as to the accuracy or completeness of the
information contained herein.

All rights are reserved by IntoPrint Technologies Inc. You must not copy, transfer, translate, etc. the
content herein without authorization. You must obtain written permission from IntoPrint Technologies
Inc, Ltd. before doing any of the above.

Energy Star is a trademark of the United States Environmental Protection Agency.

Microsoft, Windows, Windows Server and Windows Vista are registered trademarks of Microsoft
Corporation.

Apple, Macintosh, Mac and Mac OS are registered trademarks of Apple Inc.
Other product names and brand names are registered trademarks or trademarks of their proprietors.

This product complies with the requirements of the Council Directives 2014/30/EU (EMC),
2014/35/EU (LVD), 2014/53/EU (RED), 2009/125/EC (ErP) and 2011/65/EU(RoHS), as
amended where applicable, on the approximation of the laws of the member states relating
to Electromagnetic Compatibility, Low Voltage, Radio Equipment, Energy related Products
and Restriction on the use of certain Hazardous Substances in electrical and electronic
equipment.

The following cables were used to evaluate this product to achieve EMC directive
2014/30/EU compliance and configurations other than this may affect that compliance.

cable type (::tf::;) core shield
Power 1.8 0 0
usB 5.0 [ 0
LAN 15.0 U l

FCC Responsibility Party:

Oki Data Americas, Inc.

8505, Freeport Pkwy., Suite 600
Irving, TX, 75063, USA
1-856-235-2600



ENERGY STAR

Target countries of the ENERGY STAR program are the United States, Canada and Japan.
It is not applicable to other countries.
This product is compliant with ENERGY STAR v2.0 only.

Emergency first aid

Take care with toner powder:

If swallowed, give small amounts of cold water and seek medical attention. DO
NOT attempt to induce vomiting.

If inhaled, move the person to an open area for fresh air. Seek medical attention.

If it gets into the eyes, flush with large amounts of water for at least 15 minutes
keeping eyelids open. Seek medical attention.

Spillages should be treated with cold water and soap to help reduce risk of
staining skin or clothing.

Environmental information



For Your Safety

Read the User’s Manual for your safety before using the product.

Cautions related to safety

&WARNING A warning provides additional information which, if ignored, may result in a risk of personal injury.

/\ CAUTION

or damage.

General cautions

A caution provides additional information which, if ignored, may result in equipment malfunction

/\ WARNING

Q@

Do not touch the safety
switch inside the machine.
Doing so may cause electric
shock when high voltage
occurs. In addition, gears can
rotate, which may result in
personal injury.

®

Do not use an inflammable
spray near the machine.
Doing so may cause fire
since there is an area heating
up within the machine.

<

Pull the power plug out of

the socket and contact with a
customer’s service center when
the cover is unusually hot,
smoking, giving off questionable
odour, or making a strange noise.
Failure to do so may cause fire.

<

Pull the power plug out of

the socket and contact with

a customer’s service center
when a liquid such as water
enters in the internal parts of
the machine.

Failure to do so may cause fire.

<

Pull the power plug out of the
socket and remove foreign
materials such as clips when
they fall inside the machine.
Failure to do so may cause
electric shock and/or fire
leading to personal injuries.

Do not operate and/or
disassemble the machine
other than that directed in
User's Manual.

Doing so may cause electric
shock and/or fire leading to
personal injuries.

Unplug the power cord and
contact with a customer’s
service center if the machine
is dropped or the cover is
damaged.

Failure to do so may cause
electric shock and/or fire
leading to personal injuries.

Unplug the power cord
periodically to clean plug blades
and root section between

the blades. If the power plug
remains inserted for a long time,
the root section will get dusty,
and the plug may be shorted
out, which may cause fire.

Do not clean spilled toner with
a vacuum cleaner.

If cleaning spilled toner with a
vacuum cleaner, it may catch
fire due to the sparks from
electric contact.

Toner spilled on the floor should
be wiped off with wet cloth.

Do not insert materials in a
vent hole.

Doing so may cause electric
shock and/or fire leading to
personal injuries.

Do not put a cup with liquids
such as water on the machine.
Doing so may cause electric
shock and/or fire leading to
personal injuries.

Do not touch the fuser and
other parts when opening the
cover of the machine.

Doing so may cause burns.

Do not throw toner cartridges
and image drum cartridges
into fire. Doing so may cause
dust explosion leading to
burns.

O

Do not use a power cord, a
cable, or a ground wire other
than those that are indicated
in User's Manual.

Doing so may cause fire.

O

The operation of using UPS
(uninterruptible power source)
or inverters is not guaranteed.
Do not use uninterruptible
power source or inverters.
Doing so may cause fire.

/\ CAUTION

Do not come closer to the paper’s exit area when
the power is turned on, while printing.
Doing so may result in personal injury.

Q)

Do not touch a damaged liquid-crystal display.
If liquid (liquid crystal) leaked from the liquid-
crystal display gets into the eyes or mouth, flush
with large amount of water. Follow the direction
from a doctor if necessary.

Do not disassemble or forcibly open the image
drum or toner cartridge. It may scatter the
toner, which people may inhale or may stain

clothes and hand.
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Viable with SP1360/SP1360W/SP1360S

Viable with SP1360/SP1360W/SP1360S

Abundant color matching functions It is possible to print from various
can be used applications

The device has functions to The built-in Adobe PostScript3,
compensate color misalignment and PCL6 emulation, and XPS emulation
density using the control panel, and enable printing from a wide range of
can adjust the color balance. Further, applications.

colors can be adjusted, the print
results simulated, and the colors
separated and printed using the color
management system from the PC.

\\\

PostScript3

Various printings are possible
using the convenient functions

Various printings are possible using
the device convenient functions when
printing from a PC.

-14 -



Viable with SP1360/SP1360W/SP1360S

Functions can be set using the

Usable as a network printer control panel

High-quality, high-speed printing is Various device functions can be set
possible from various applications. such as changing paper size and
(With A4[7, 50 sheets a minute using network setup from the control panel.
color/monochrome printing.) As it Further, administrator passwords can
is possible to connect to a network also be set using the control panel.

and print from multiple PCs, office
space saving and cost reductions are
achieved.

(This manual page 55)

0

[ )

Functions 1/2 Page
Print Information

B Print Secure Job

a Menus

ElAdmin Setup

a E Print Statistics

O Use Online button to return to standby screen...

Power consumption is reduced
when the printer is not in use
The printer status can be checked, (Power save mode)
and error messages and help

displayed, on the control panel If the device is not used for a fixed

period of time, power save mode

Either "Remaining toner quantity starts automatically (power save
display" or "Tray information display" mode/sleep mode) to enable power
can be displayed in the control panel consumption to be reduced. Press the
standby screen. If an error occurs [POWER SAVE] button to enter power
in the device, you can work while save mode manually. When in sleep
checking the control panel messages. save mode, the [POWER SAVE] button

(This manual page 24) is lit green.

(This manual page 105)

\

@ MeNy (8

CANCEL

consumption

- 15 -



Viable with SP1360/SP1360W/SP1360S

Use the help function to check if

Increasing the quantity of paper you do not understand something

that can be fed or if trouble occurs when using
the device

Mounting the optional expansion Press the [HELP] button on the

tray unit enables the continuous control panel to display messages

printing of large quantities and the for resolutions if trouble occurs, and

printing of different paper sizes to be how to troubleshoot. (Animations will

implemented smoothly. be displayed depending on the error

(This manual page 31) details.)

(This manual page 27)
(Troubleshooting/Daily Maintenance
Manual)

©)

POWER SAVE

ATTENTION

- 16 -



Checking the product

1. Before use

This chapter explains the package contents of the product and the nomenclature and functions of the parts.

C! Note)

® The SP1360S Spot Color kit is a separate package. For the set-up method, see the "Separate Volume Spot Color Guide".

asn a.0jog

Checking the product

Checking the Package (o)

® For SP1360W, White is also supplied as an accessory.
Contents PP Y

® Image drum (One each of black, yellow,
Open the packing case and check the contents of magenta, and cyan)
the box.

/\ CAUTION |There is a risk of injury. & %

® SP1360 models weigh approx. 98kg*, and
SP136W/SP1360S models weigh approx.
111kg*, so make sure to use at least 4 people .
minimum when lifting. (o)

® For SP1360W, White is also supplied as an accessory.
*: Includes consumables such as the image drum and

. ® The image drum is set inside the device at the
toner cartridge, etc.

factory.

g2 Reference ® Transfer Roller Unit

® See "Opening the Package and Installation” (P.36) for
how to open the package.

® See “Mounting the Expansion Tray Unit (Optional)” (P.44)
for the expansion tray.

® A maximum of four additional tray units (trays 2 to 5) can
be mounted.

® Printer Unit
rinter Unt ® Set-up Guide

=

1 2 g

(1t Note)

® LAN cables, USB cables, and hubs are not included with
the printer. Prepare them separately.

. ® The packing case and buffer material are required when
® Toner cartridge (One each of black, yellow, shipping the device. Do not discard them, but store them

magenta, and cyan) safely.

-17 -



los)
o}
o
g
(]
C
[%2]
(0]

Parts Nomenclature and Functions

Parts Nomenclature and Functions

Front/ Right Side

(DToner Cover
Open this to replace the toner cartridge.

(@Control Panel

Displays the device status and menus, and sets the
functions.

“Control Panel” (P.24)

®Front Lamp
Flashes when receiving data and while in power save.

@®Front Cover
Open this to remove the image drum, waste toner
box, and belt unit.

®Power Switch

® You can turn ON and OFF the power supply when
the main power switch is ON.

® Cancel the OFF mode.

(®Tray 1/Paper Cassette

This is the paper tray mounted as standard. Plenty of
paper can be set at one time.

Set the print surface face-down.

(DFace Down Stacker
The printed sheets are placed printed-side down and
discharged.

(®Right Side Cover
Open this to replace the multi-purpose tray feed
roller, and to clear paper jams.

@Tray Side Cover
Open to clear paper jams from trays 1 to 5.

(oCarrying Handles
Hold these at the same time as the carrying lever
when carrying the device.

()Carrying Lever
When carrying the device, pull out this lever, and
hold the carrying handles at the same time.

(0pener
Open the right side cover.

- 18 -



Parts Nomenclature and Functions

Back/Left Side

-—

asn aJ0jog

(MInterface ®Exit Unit
There are a LAN (network) interface connector and a Open this when replacing the fuser unit or transfer
USB interface connector. See “Interface” (P.23) for roller unit, or to clear paper jams.

the interfaces.

(@Access Cover @Duplex Unit

Open this when mounting the optional built-in HDD. Implements duplex printing.

(®Carrying Handles (®Carrying Lever

Hold these at the same time as the carrying lever When carrying the device, pull out this lever, and
when carrying the device. hold the carrying handles at the same time.
(@®Power Connector (®Main Power Switch

Connect the enclosed power cable here. Turns ON and OFF the device main power supply.

(®Left Side Cover
Open this to clear paper jams.

- 19 -



Parts Nomenclature and Functions

Printer Interior

Front Interior

los)
o}
o
S
(]
C
[%2]
(0]

(DToner Cartridge @sSlot
® The remaining toner quantity is normally displayed Set the toner cartridge here.
when "Display remaining toner quantity" has been “Mounting Consumables” (P.39)

set using the control panel standby screen.
® The toner cartridge is a consumable.

®
@
®
@
(®Belt Unit (DHandle
This device copies the toner to the paper. Hold this handle when removing the belt unit.
The belt unit is a replaceable maintenance part.
(@Lock Lever Knob (®Image Drum/Slot
Secures the belt unit. ® The image drum is set in the slot.

® The image drum is set inside the printer main unit
before shipment from the factory.
® The image drum is a consumable.

(®Belt Unit Lock Lever (@®Waste Toner Box

Secures the belt unit. This box holds the waste toner.
When the waste toner box is full, a message is
displayed on the control panel. The waste toner box
is a replaceable maintenance part.

(®Belt Unit Lever
Secures the belt unit.

- 20 -



Parts Nomenclature and Functions

R_ight Side Interior

(DMulti-purpose Tray/MP Tray

You can print on various papers, including postcards
and envelopes, etc.

Further, use when printing to the topside of the
paper that has been set. Set the paper size using the
control panel when using as a regular tray.

@Paper Guide
Stabilizes the paper by adjusting the paper guide to
the width of the paper to be printed.

(®Set Lever

Move the paper guide left and right while pulling the
lever towards you when adjusting the paper guide to
the width of the paper. The paper guide is secured
when the set lever is returned to its original position.

@®Auxiliary Supporter
Maintains the paper when paper has been set in the
multi-purpose tray.

®Paper Supporter

Sets the paper to be printed in the multi-purpose
tray.

Sets the print surface face-up.

-21 -
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Parts Nomenclature and Functions

Left Side Interior

(DFace Up Stacker
Open the stacker to set and eject the paper face-up.

@Auxiliary Supporter
Secures so that the ejected paper does not droop.

(®Fuser Unit
This unit fixes the toner to the paper.
The fuser unit is a replaceable maintenance part.

(®Fuser Unit’s Jam Release Lever

Pull up this lever when a paper jam occurs in the
fuser unit.

(®Exit Unit Knob

Pull this knob towards you, and pull out the exit unit.

(DExit Unit
The fuser unit, transfer roller unit, and duplex print
unit are mounted to this unit.

®Paper Supporter
Secures the paper ejected to the face-up stacker.

(®Fuser Unit’'s Lock Lever
Secures the fuser unit.

@Transfer Roller Unit

Transfers the toner to the paper.

The transfer roller unit is a replaceable maintenance
part.

(0Transfer Roller Unit’s Lock Lever
Secures the transfer roller unit.
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Interface
1
&
o
@
=
3
\
Ell ®
[
Ja Ll/ @
(DLAN (network) Interface Connector (@USB Interface Connector
Connects the LAN cable. Connects the USB cable.
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Control Panel

HEeLP

® <)

BACK éJ‘
D, O
o—t O
N

| ©lolo)

Oloéé
CANCEL

GHI JKL  MNO

D ®

PQRS TUV WXYZ

0 ®O©O

CLEAR,
/,

® @

(DLiquid crystal panel

® Displays the device status and menus.

® There are two types of standby screen: "Remaining
toner quantity display" and "Tray information
display".

@[HELP] button

Displays the help screen.

Lit orange when help messages can be referenced,
such as explanations of the error that has occurred
or the cancellation procedure.

(®[BACK] button
Returns to the previous page.

@®[OK] button (MENU button)
Determines the selected item and set values.

®[POWER SAVE] button
® Turns ON and OFF power save mode.
® Cancels sleep mode.

®ATTENTION lamp

Displays the device status.

Normally OFF.

Lit or flashes orange if an error occurs.

@Scroll button AV (MENU button)

® Displays the menu screen to select an item, and
then scrolls up (or down) one page.

® Can be used to enter numbers in the numerical
input screen.

®[ON LINE] button
® Switches between online and offline.
® Lit green when online, and OFF when offline.

@Ten-key pad (1 to 0, *, C)

® Use to enter numerical values and passwords.

® Press the [*] ([Fn]) key in the standby screen to
display the "function number input" screen, and to
enter menu items directly.

(O[CANCEL] button
Use to cancel a print, or to cancel the settings.
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Main Control Panel Features
The control panel can be used to check the device status and implement various device functions.

-—

The toner cartridge can be replaced while viewing the liquid crystal display on the control panel.
Further, you can also perform operations while checking the messages displayed on the liquid crystal
panel if paper jams or device malfunctions occur.

Reference

® See the control panel menus table “Table of control panel menu items” (P.119).

asn aJ0jog

Control Panel Appearance
This section explains the main control panel operations and control panel appearance.

The color display of the selected item is inverted.

There are two types of standby screen: "Remaining The name of the menu that is displaved
toner quantity display" and "Tray information display". played.
Displays the number of pages in the menu

displayed on the liquid crystal panel.

| Functions 1.’2 Paae
[ —— H

Ready To Print

Print Information

# B Print Secure Job
100% 100% 100% 100% "M vienns
B p-)Admin Setup '
&) | Print Statistics
O Use Online button to return to standby screen..

Yellow Magenta Cyan Black

If there is a scroll bar, there are items that are
On LiNe not displayed in the liquid crystal panel. Press
O ABC DEF the scroll button A or ¥ to display them.

Menu
GHI ]KL MNO A password must be entered to display the [Admin
“ANCEL ) Setup]. Enter the administrator password (factory
G)_ Q PaRs TUV wxvz setting is the first 10 digits of the serial number)

® . @ in the password input screen.
TTENTION J

|~ UL

Press the scroll button A or the ¥ to display the "Functions"

@ @)5@%

menu screen as shown on the right.

® If there is a selection menu at the next level or set values for an item, select the item and press the
[OK] button to display the next screen.

® If a set value is displayed, press the [OK] button to confirm the value that has been set. ( is
displayed to the left of the value.)
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m Standby Screen

There are two types: "Remaining toner quantity

display" and "Tray information display".

Use the following procedure to switch the
standby screens.

Press either the scroll button A or v

on the control panel to display the
"Functions" screen.

Functions

n Configuration

a Print Information
B Print Secure Job
ﬂ Menus

B EAdmin Setup
B BPrint Statistics

O Use Online button to return to standby screen...

1/2 Page

Press the scroll button ¥ several times
to select the [Admin Setup], and then

press the [OK] button.

Functions

n Configuration
g Print Information
B Print Secure Job

ﬂ Menus

B B Print Statistics

(0) Use Online button to return to standby screen...

1/2 Page ‘

3 Use the 10-key pad to enter the
administrator password.
The default factory-set password is

the first 10 digits of the serial number.

Press the [OK] button after entering
each individual character.

Enter Password

uuu
(6 -12 digits )

() Use Online button to return to standby screen.

4 Press the [OK] button.

Press the scroll button ¥ several times
to select [Panel Setup], and then press
the [OK] button.

Admin Setup

n Panel Setup

B Time Setup

B Power Setup

ﬂ Others Setup

B Settings

B Change Password

O Use Online button to return to standby screen...

2/2 Page

Press the scroll button ¥ several times
to select the [Idle Display], and then
press the [OK] button.

To display the "remaining toner
quantity" in the standby screen, select
[Toner Gauge], and then press the [OK]
button.

To display the "tray information", select
[Paper Size], and then press the [OK]
button.

Press the [ON LINE] button to return to
the standby screen.

(" HELP " — R
ENU N LINE
O ®
(&) (5)(6)
GHI KL NNO

PQRS TUV WXYZ

PO,

c@‘“

@ ATTENTION
N

Ready To Print

100% 100% 100% 100%

Yellow Magenta Cyan Black
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m Error Screen

If a printer error occurs, the maintenance lamp
will either turn ON or flash, and a message will
be displayed in the liquid crystal panel.

Depending on the error, the error countermeasure
and animations may be displayed in the liquid
crystal panel in addition to the message.

Reference

® "Troubleshooting/Daily Maintenance Manual"

Press the control panel buttons in the error
screen to set the device to the following
statuses.

[POWER SAVE] button:

The printer will enter power save mode. Press
the [POWER SAVE] button when the device is
in power save mode to return to the standby

screen.

[HELP] button:

Press the [HELP] button when it is lit to display
the relevant help message for the error that is
currently displayed.

[OK] Button:

In the case of errors for which the error message
vanishes when the [OK] button is pressed, the
printer will return to the standby screen.

[ON LINE] button:

In the case of errors for which the error message
vanishes when the [ON LINE] button is pressed,
the printer will return to the standby screen.

[CANCEL] button:
The following errors can be cancelled.

® MPTray Empty

® Change [MEDIA_SIZE] [MEDIA_TYPE] in
[TRAY]

® [TRAY] Empty
® Check Paper in [TRAY]
® Paper Size Error

® Change [MEDIA_SIZE] [MEDIA_TYPE] in
MPTray

® The print data size is too large to store it into
printer memory

® Toner Empty

® Multiple sheets of paper were fed at once
® Paper cassette is not in [TRAY]

® Feed print job manually

H Help Screen

Press the [HELP] button to display the help
screen. Further, press the [HELP] button when it
is lit to display the relevant help message for the
error that is currently displayed.

-—

Help {Error Code:311) 1/2 Page

[Context]
A cover is open.

asn aJ0jog

Press the A scroll button displayed in the help
screen to scroll to the previous page. Press the
W scroll button to scroll to the next page.

To close the help screen, press the [HELP] button
again.

® Press and hold either the A scroll button or ¥ to scroll
through the pages at approx. 0.5-second intervals.

® The help screen can also be closed by pressing the [BACK]
button, [ON LINE] button, or [CANCEL] button.
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Adjusting the Control Panel Select [Panel Setup], and press the [OK]
Brightness button.
Use the following procedure to adjust the Admin Setup 2/2 Page
brightness of the liquid crystal panel. @ Pane! setup
® BTime Setup
g“ B Power Setup
::_5 ® The brightness (backlight) of the liquid crystal panel can @ Cthers Setup
a be set individually for during control panel operations and @ settings
when in power save mode. @ Change Password
O Use Online button to return to standby screen...

Press either the scroll button A or v

on the control panel to display the
"Functions" screen. 5 When adjusting the brightness for

during control panel operations, select
[Panel Brightness During Operating],
and press the [OK] button.

Functions 1/2 Page
n Configuration

Print Infermation

B Print Secure Job

Panel Setup 1/2 Page |
O venus () Near Life Status
Admin Set
B E‘ min Setup B Near Life LED
B p)Print Statistics B dle Displ
e Lisplay

(0) Use Online button to return to standby screen. ..
Panel Brightness During Operating

B Panel Brightness While Power Save

Press the scroll button ¥ several times @ Pane! Backlight Timer

to select the [Admin Setup], and then () Use Online button to return to standby screen...

press the [OK] button. When adjusting the brightness for when in
Functions 1/2 Page power save, select [Panel Brightness While
0 Configuration Power Save], and press the [OK] button.

g Print Information

. Panel Setup 1/2 Page

B Print Secure Job -
n Near Life Status

ﬂ Menus )

, B Near Life LED
B EAdmln Setup .
. — a Idle Display

B B Print Statistics . . .

ﬂ Panel Brightness During Operating

(0) Use Online button to return to standby screen...

B Panel Brightness While Power Save
a Panel Backlight Timer

Use the 10'key pad to enter the administrator (L) Use Online button te return te standby sereen...
password. The default factory-set password is
the first 10 digits of the serial number. Press Press the [ON LINE] button to return to
the [OK] button after entering each individual the standby screen.
character. T N
Enter Password @ o %E
****** ABC DEF
(6 - 12 digits ) 7~ N\

GHI JKL  MNO

CANCEL
Q PQRS TUV WXYZ

Fn

O Use Online button to return to standby screen.

100% 100% 100% 100%

(N

Yellow Magenta Cyan
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Using the 10-Key Pad

Use to input alphanumeric characters.

The characters that can be entered when each
key is pressed, and the toggling of the input
characters, are described below.

10-key
(" HELP " onL J
ENU N LINE
O )

GHI JKL  MNO

CANCEL

POWER SAVE Q PQRS TUV WXYZ
-
ATTENTION C'-EAR/

[1]1

[2Zla—-b—>c—>2—a
[3]d—>»e—-f—-3—>d
[4]g—>h—-i—>4->g

[5]j-k—>1->5-]
[6]mM—>n—>0—>6—>m
[7lp—>g—->r—>s—>7-p
[B]tu—>Vv—->8—t
[OlW—>X—>y—>Z—>9—>w
[0]O

The following two key functions are as described
below.

[Fn] key:

Use to display the function number shortcut.
(Enabled when the standby screen is displayed.)

[CLEAR] key:

Conceals each character individually when
entering a password.

® If entering "abc", press the buttons in the
following order: [2]—[OK] button—[2]—[2]—[OK]
button—[2]—-[2]—-[2]—[OK]

B Function Number Input Screen
When "Ready To Print" is displayed in the
standby screen, press the [Fn] key and then
press the desired number to display the relevant
menu item.

1 Press the [Fn] key.

(" HELP

@ MENU

ON LINE

Q ...

ABC DEF

GHI ]KL MNO

CANCEL

POWER SAVE Q PARS  TUV WXYZ
CRASsg
ATTENTION Fn CLEAR

The function number input screen will
be displayed, so use the 10-key pad
to enter the (3-digit) menu number to
be displayed, and then press the [OK]
button.

Function Number

Enter 1-3digit Number

The menu will be displayed, so check or
change the set values.

Use Online button to return t...

-—

asn aJ0jog
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Function Numbers Table

Function No. Function No. Menu Item
54 Media Weight (Tray 5)

55 A3Nobi Paper (Tray 5)

56 Legall4 Paper (Tray 5)

57 A5LEF/A6/Hagaki Paper (Tray 5)
58 A5SEF/Oufuku Hagaki Paper (Tray 5)
59 Other Size (Tray 5)

80 Paper Feed Tray

90 Paper Size (MPTray)

91 X Dimension (MPTray)

92 Y Dimension (MPTray)

93 Media Type (MPTray)

94 Media Weight (MPTray)

95 Tray Usage (MPTray)

100 Print Information (Configuration)
101 Print Information (Network)
102 Print Information (Usage Report)
103 Print Information (Error Log)
200 Power Save Time

201 Sleep Time

202 Auto Power Off Time

210 Error Report

220 Print Position Adjust (MPTray)
221 Print Position Adjust (Tray 1)
222 Print Position Adjust (Tray 2)
223 Print Position Adjust (Tray 3)
224 Print Position Adjust (Tray 4)
225 Print Position Adjust (Tray 5)
230 Paper Black Setting

231 Paper Color Setting

232 Trans. Black Setting

233 Trans. Color Setting

234 SMR Setting

235 BG Setting

236 Drum Cleaning

237 Hex Dump

238 Transfer Roller Cleaning

300 Adjust Density

301 Adjust Registration

302 Print Color Tuning Pattern

310 Cyan Density

311 Magenta Density

312 Yellow Density

313 Black Density

314 White Density

314 Clear Density

Function No. Function No. Menu Item
1 Print Secure Job (Encrypted Job)

2 Print Secure Job (Stored Job)

10 Paper Size (Tray 1)

11 X Dimension (Tray 1)

12 Y Dimension (Tray 1)

13 Media Type (Tray 1)

14 Media Weight (Tray 1)

15 A3Nobi Paper (Tray 1)

16 Legall4 Paper (Tray 1)

17 ASLEF/A6/Hagaki Paper (Tray 1)

18 A5SEF/Oufuku Hagaki Paper (Tray 1)
19 Other Size (Tray 1)

20 Paper Size (Tray 2)

21 X Dimension (Tray 2)

22 Y Dimension (Tray 2)

23 Media Type (Tray 2)

24 Media Weight (Tray 2)

25 A3Nobi Paper (Tray 2)

26 Legall4 Paper (Tray 2)

27 A5LEF/A6/Hagaki Paper (Tray 2)

28 A5SEF/Oufuku Hagaki Paper (Tray 2)
29 Other Size (Tray 2)

30 Paper Size (Tray 3)

31 X Dimension (Tray 3)

32 Y Dimension (Tray 3)

33 Media Type (Tray 3)

34 Media Weight (Tray 3)

35 A3Nobi Paper (Tray 3)

36 Legall4 Paper (Tray 3)

37 A5LEF/A6/Hagaki Paper (Tray 3)

38 AS5SEF/Oufuku Hagaki Paper (Tray 3)
39 Other Size (Tray 3)

40 Paper Size (Tray 4)

41 X Dimension (Tray 4)

42 Y Dimension (Tray 4)

43 Media Type (Tray 4)

44 Media Weight (Tray 4)

45 A3Nobi Paper (Tray 4)

46 Legall4 Paper (Tray 4)

47 A5LEF/A6/Hagaki Paper (Tray 4)

48 ASSEF/Oufuku Hagaki Paper (Tray 4)
49 Other Size (Tray 4)

50 Paper Size (Tray 5)

51 X Dimension (Tray 5)

52 Y Dimension (Tray 5)

53 Media Type (Tray 5)




Using the Device to its Fullest Extent

Using the Device to its Fullest Extent

-—

The following options are supplied for the device.

asn a.0jog

B Expansion tray units (trays 2/3/4/5)

Expansion tray unit Expansion tray unit with casters Large-capacity expansion tray unit
(Expandable up to 2 levels) (N36130A) (3 trays in one, with casters)
(N36110A) (N36120A)

(! Note)

® If expanding from level 3 upwards, use a large-capacity expansion tray unit.

B Built-in HDD
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Installing the Device

This chapter explains the methods for setting up the device, and for connecting the device to a PC and

installing the printer drivers.

(! Note)

® Customers who have purchased SP1360S should also see the "Separate Volume Spot Color Guide".

Installing the Device

For safe and pleasant use of the device, install in a location that satisfied the "installation environment"
and "installation space" described in the "installation conditions". Further, the conditions also describe
the installation precautions. Make sure to read them before use.

Installation Conditions ® Installation Space _
Make sure the area around the device has

Consider the following environmental conditions
before selecting the device installation location.

m Installation Environment
Use in a location where temperature and
humidity are within the following ranges.

Ambient 10°C to 32°C
temperature:

Ambient 20% to 80%RH (relative humidity)
humidity:

Max. wet-bulb  25°C
temperature:

® Make sure there is no condensation.

® If installing in a location where the ambient humidity is
30% or less, use a humidifier or static prevention mat.

the following space, and select a location that
can support the weight of the device before
installing. (The main unit weights are as follows:
SP1360: Approx. 98kg*; SP1360W/SP1360S:
Approx. 111kg*.)

*: Includes consumables such as image drums and toner
cartridges, etc.

® Plane view
200mm

1770mm

620mm ] 460mm

=———— |

( : 0 f :; =~

1420mm + ]

o

® Front view

~ 1040mm
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Installing the Device

® Front view (with expansion tray mounted) H Installation Precautions
/\ WARNING
400mm
® Do not install close to high-temperature locations
— or naked flames.
@‘ ® Do not install in locations where chemical
= reactions occur (e.g., laboratories).
® Do not install close to combustible solutions such
/ as alcohol or thinners, etc.
x ® Do not install within reach of small children.
0 7‘1560mm ® Do not install in an unstable Iocz_ation (e.g.,
- unsteady tables or sloping locations, etc.)
= —— ® Do not install in humid or dusty locations, or in
Bl m———— locations in direct sunlight.
O ® Do not install in environments with salt air or
= corrosive gas.
B [——y| ® Do not install in locations with major vibration.
%b ——— ® Do not install in locations where the device air
©

ol holes are blocked. Use the following illustrations
to check the air hole position.

Right
side




Installing the Device

/\ CAUTION

® Do not install directly on shaggy rugs or carpets.

® Do not install in locations with poor air circulation
or ventilation such as sealed rooms, etc.

® Make sure of ventilation if using continuously for
long hours in a small room.

® Install away from strong magnetic fields and
sources of noise.

® Install away from monitors and TVs.

® When moving the device, hold the carrying lever
and carrying handles.

® The main device weight is approx. 98kg* for
models SP1360 and approx. 111kg* for model
SP1360W/SP1360S. When lifting or moving the
device, make sure to use at least 4 people.

® Make sure of the ventilation if printing large
quantities or using the device continuously for
long hours.

*: Includes consumables such as image drums and toner
cartridges, etc.
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Installation Procedure

Work according to the relevant procedures and the customer installation conditions. If not mounting
any options, skip the reading of the procedures described as "Optional”.

OPening the Package and The main unit weights are as described below.

Installation

This section explains the procedure from opening
the package to removing and installing the
product.

SP1360

Opening the Package and Moving Approx. 98kg Approx. 82kg
the Device

Make sure to install in a sufficiently robust SP1360S
location that can support the weight of the SP1360W
device and its options. Do not install in unstable
locations such as on unsteady tables or slanted
locations, or in locations with strong vibrations.
Doing so risks causing injury due to the device
falling or toppling.

® For device installation locations, see “Installation
Conditions” (P.33).

Approx. 111kg Approx. 91kg

A CAUTION |There is a risk of injury. &

® The weight of the device is approx. 98kg* for
models SP1360, and approx. 111kg* for model
SP1360W/SP1360S, so make sure to use at
least 4 people to lift.

*: Includes consumables such as image drums and toner
cartridges, etc.



Installing the Device

Open the package, and remove the
device accessories (1), and enclosed
manual, protective equipment, and

shock-absorbing material ().

( note)

® The packing and protective equipment are used
when shipping the device, so store them carefully.

Remove the cover bag enclosing the
main printer unit.

(1 Note)

® Do not remove the tape securing the protective
equipment, paper feed trays, and side covers before
transporting the device to its installation location.
The trays and covers opening during transport may
cause unexpected injury.

Remove the three carrying levers at the
bottom of the printer (D), and check
the three locations of the carrying
handles ().




Installing the Device

4

Hold the carrying levers while grasping 7 Pull out the tray 1 paper cassette.
the carrying handles, and use at least 4
people to lift and carry simultaneously.

( note)

® Make sure not hold anywhere other than the
carrying handles, such as the paper feed trays or
side covers, etc. Doing so may cause injury due to
dropping the device.

® Make sure to use 4 people min. for lifting and
carrying so there is no back pain, etc.

Slide the paper guide and take out the

sheet retainer.

Gently lower the device into its
installation location.

(1 note)

® Gently and carefully lower the device. There is a
risk of crush injuries to hands, etc.

Peel off the five protection tapes from
the printer main unit.




Installing the Device

Mounting Consumables 5 Close the toner replacement cover.

m Setting the Toner Cartridge

Remove the toner cartridge from its

cover bag.
Z fz

ﬁha-ke tth?I tone(; cart_ridﬁe both B Remove the image drum stopper
orizontally and vertically.

® The image drum is set inside the device at the factory.

Reference

® For the methods of replacing the image drum, see
"Troubleshooting/Daily Maintenance Manual", or the device
help.

The stopper is mounted to the image drum in

the device at the factory.

( note) Make sure to use the following procedure to
@ Do not drop the toner cartridge or tap it on the remove the stopper before use.
floor. Doing so may damage the cartridge.

Open the front cover.
3 Open the toner replacement cover.

Check the position of the slot that has a label stuck
on it with the same letters and colors, and firmly
push the toner cartridge in as far as it will go.




Installing the Device

Gently raise the (blue) lever (1), and 3 Place the image drum that has been
remove the image drum (@) while removed onto a flat surface covered
being careful not to touch the green with paper, and remove 4 stoppers
cylinder with your hands. (orange) in the direction of the arrows.

(! Note)

® Do not expose the image drum to direct sunshine
or strong light (approx. 1,500 lux or above). Do not
leave it for more than 5 minutes even under indoor
light.

® Be careful not to touch or scratch the image drum
(green cylinder).




Installing the Device

4 Align the (red) arrow labels on the m Set the transfer roller unit.
image drum with the arrows on the
device, and gently insert into the slot Lift the exit unit opener (D), and pull
and push in firmly all the way while out the exit unit.

being careful not to touch the green
cylinder with your hands.

Raise the lock levers (blue) at both ends
of the transfer roller unit installation
( Note) location of the exit unit.

® Be careful not to touch or scratch the image drum
(green cylinder).

Reference

® Model SP1360S requires the Spot Color kit to be set. For
details, see the "Separate Volume Spot Color Guide".



Installing the Device

Take out the transfer roller unit from Set the transfer roller unit to the exit
the package. unit.

( Note)

® Do not touch sponge of the transfer roller unit.

® The toner used for quality inspection might be adhered to
the roller surface. The toner on the roller surface will not
affect the performance.

Push both sides of the lock lever (blue)
down.




Installing the Device

Setting Paper Set the paper with the print surface
y face-down.

This section explains how to set the paper in tray
1 or trays 2/3/4/5.

® In this section, setting paper in tray 1 is used as an
example. Set trays 2 to 5 using the same procedure.

1 Pull out the tray 1 paper cassette (D).

(! Note)

® Do not exceed the "v" symbol (('D) on the paper
guide when setting the paper.

Slide the paper guide () and paper
stopper (@) to align to the size of the
paper that has been set.

® Set so there is no gap between the paper and the
paper guide or paper stopper.

Use the paper guide to secure the
paper.

6 Return the paper cassette to the tray.

Thoroughly sort the paper. Carefully
align the edges of the paper
horizontally.




Installing the Device

Mounting the Expansion B Expansion tray unit with casters

Tray Unit (Optional)

Mount the (optional) expansion tray unit to
increase the quantity and types of paper that
can be set in the device.

The expansion tray unit has a large-capacity tray
comprising the 1st and 3rd trays.

The device can expand to a maximum of 4 trays
(5 including the standard tray).

The expansion trays can be mounted to either O Mounting the expansion tray unit with
the main printer unit or the expansion tray unit. casters to the main printer unit

(1 Note)

® If placed on a table, the expansion tray unit can be
expanded to 2 trays (3 including the standard tray).

® If placed on a table, the large-capacity expansion tray unit
cannot be used.




Installing the Device

® The expanded trays are called tray 2, tray 3, tray 4, and

tray 5.

Expansion
tray unit

Large-capacity
expansion tray
unit

Tray 1 (standard)
Tray 2
Tray 3
Tray 4
Tray 5

1 Remove the expansion tray unit from
the package, and remove the buffering
and protective materials.

2 Mount the main printer unit to the
expansion tray unit.

Gently lift the main unit using 4 people
min., and align the holes on the base
(D) to the 2 protrusions (@) on the
expansion tray unit.

Gently place on the other while
matching the main unit to the position
of the vertical lines on the back of the
expansion tray unit.

/N\ CAUTION| There is a risk of injury. | /N

® The weight of the device is approx. 98kg* for
models SP1360, and approx. 111kg* for model
SP1360W/SP1360S, so make sure to use at
least 4 people to lift.

*: Includes consumables such as image drums and toner
cartridges, etc.

(1t Note)

® If the device is connected to a power supply, turn OFF the
device power, and remove the cables. For how to turn OFF
the power supply, see “Turning OFF the Power Supply”
(P.52).



Installing the Device

(! Note)

® If using the expansion tray unit and large-capacity
expansion tray unit, first mount the expansion tray
unit to the large-capacity expansion tray unit, and then
mount the main printer unit to the expansion tray unit.

Printer
base hole

® For the expansion tray unit and large-capacity expansion tray
unit with casters, adjust the caster locks (x2) and feet (x2).

- 46 -

Push down the lock levers on the
casters (x2) at the front of the device
to lock the casters.

Loosen the nuts (x2) at the top of the
feet on the right of the device.




Installing the Device

Rotate the nuts and bolts at the bottom
of each foot to lower the feet.

When each foot has reached the
ground, tighten the nuts at the top to
secure the tray unit.

(1t Note)

® When moving the device, rotate and thoroughly lift the
screws on the feet of the large-capacity expansion tray
unit, and move while remote from the ground.

® If mounting the expansion tray unit, it is necessary to implement
“Connecting Cables” (P.57) and “Connecting Power
Cables” (P.51) before making the settings for the printer
drivers to detect the expansion tray unit.
See “Adding Options” (P.76).

If moving the printer or replacing consumables
or maintenance units, or setting paper in the
tray, check the following points to prevent the
printer from toppling.

® Do not press the front cover when the printer
font cover is open.

® Do not press on the cassette from above when
the cassette is pulled out.




Installing the Device

Mounting the Built-in HDD Check that the internal LED lamp (D) is
(Optional) OFF.

Mount the (optional) built-in HDD to increase the o 0 @_@
memory capacity or implement secure printing. -

ﬂ

O

Reference

® For the functions required by the HDD, see "Advanced".

o 0

O

iz

o

® Built-in HDD

Align the screws (x2) on the built-in
HDD to the holes on the device.

\\ SN
1 Turn OFF the device power supply, and

remove the cables.

C! Note)

® When turning OFF the power supply, make sure
to press the power switch and wait for shutdown
before turning OFF (O) the main power switch.

Reference

® “Connecting Power Cables” (P.51)
® “Turning OFF the Power Supply” (P.52)

e

&
=
e

2 Loosen the screws on the access cover Rotate the screws (x2) in the direction
at the back of the printer (1)), and of the arrows to tighten securely.
open the door ().

Connect the HDD connectors to the
device.




Installing the Device

Close the access cover.

Connect the cables, and turn ON the
device power supply.

1 Check that the standby screen is
displayed in the liquid crystal panel.

Ready To Print

100% 100% 100%
Yellow Magenta Cyan a

1 Print the "Configuration".

Press either the scroll button A or v
on the control panel to display the
"Functions" screen.

Functions 1/2 Page
n Configuration

Print Information

B Print Secure Job

ﬂ Menus
E|Admin Setup
ﬂ E' Print Statistics

O Use Online button to return to standby screen...

® Print the "Configuration" on A4 size paper. Set A4
size paper in the paper feed tray.

1 Press the scroll button ¥ to select [Print
Information], and then press the [OK]
button.

Functions 1/2 Page
n Configuration

g Print Information

a Print Secure Job

ﬂ Menus
EAdmin Setup
a E Print Statistics

O Use Online button to return to standby screen...

1 When the [Configuration] have been
selected, press the [OK] button.

Print Information 1/2 Page
n Configuration

a Demo Page

EXFile List

B3 Ps Font List

PCL Font List

a Usage Report

O Use Online button to return to standby screen...

1 When [Execute] has been selected,
press the [OK] button.

Configuration

ﬂ Configuration n Execute

i O Use Online button to return to s.. |

1 Check that the HDD has been added to
the "Configuration”.

Reference

® “Printer Information” (P.54)




Turning ON/OFF the Power

Turning ON/OFF the Power

Power Supply Precautions Power Supply Conditions

Observe the following power supply conditions.

There is a risk of getting
/\ WARNING | an electric shock and/or @ A Current: 110 - 127VAC
causing fire. (Range 99 - 140 VAC)
220 - 240VAC

® Be sure to cut off the power supply when

attaching or removing the power supply plug (Range 198 - 264VAC)

or the earth wire. Power 50/60 Hz + 2%
. fr ncy:

® Be sure to connect an earth wire to the equency

grounding terminal of exclusive use. o)

. ! Not

® Please do not connect with the ground of a - _

water pipe, a gas pipe, and a telephone wire, ® If the power supply is unstable, use a voltage regulator.

or lightning rod without fail. ® The maximum power consumption of the device is 1500W.
® Make sure to connect with the ground terminal Check that there is sufficient voltage capacity.

before connecting the power cord to the ® Operations cannot be assured if using an uninterruptible

power supply plug. power supply (UPS) or inverter. Do not use an

. . . uninterruptible power supply or inverter.
® Be sure to perform extraction and insertion of P P PPYY

the power cord with a power supply plug.

® Insert the power supply plug into the wall
socket securely.

® Do not touch the power cord, or machine, if
your hands are wet.

® Install the power cord in a location where it will
not be stepped on, and do not place objects on
the power cord.

Do not twist, bind, or knot the power cord.
Please do not use a damaged power cord.
Do not carry out foot wiring.

Do not connect this machine and other electric
products to the same wall socket. If connected
simultaneously with an air-conditioner, a copy
machine, shredder, etc., electric noise may
interfere with operation. When the connection
with the same wall socket is unavoidable,
please use a commercial noise filter or a
commercial noise cut transformer.

® Use the attached power cord and insert it
directory with the ground terminal. Do not use
power cords intended for other products with
this machine.

® Do not use an extension cord. When use is
unavoidable, use a cord rated higher than 15A.

® Use of an extended cord may cause AC
voltage decrease and interfere with normal
operation.

® During printing, do not shut off the power
supply or pull out the power supply plug.

® When not in use for consecutive holidays or
longterm travel, pull out the power cord.

® Do not use the attached power cord for other
products.




Turning ON/OFF the Power

Connecting Power Cables Turning ON the Power
Supply

1 Check that the device power supply is
turned OFF. @cd

® For the SP1360S model, do not turn ON the power supply
before the Spot Color kit has been set.

The device is OFF when the main power
switch is in the (O) position.

-

1 Turn ON (I) the main power switch.

-

2 Secure insert the enclosed power cable
into the device power connector. Press and hold the power switch for
approx. 1s.

When the power supply is ON, the LED
lamp for the power switch will turn ON.

s

S22

Power cable

3 Insert the power plug into the power
outlet.

® The "IntoPrint" logo screen will be displayed in the liquid
crystal display of the control panel when the device starts.
Wait a moment until the standby screen is displayed, and
the printing is enabled.

® When the power supply is turned ON for the first time, the
device auto initialization will start. Wait until the standby
screen is displayed in the liquid crystal display on the
control panel.



Turning ON/OFF the Power

Turning OFF the Power
Supply

During normal use, use the following procedure
to turn OFF the power supply.

(1 Note)

® Once shutdown has been implemented, it cannot be
stopped. To turn ON the device power supply again, wait
until shutdown has finished, and then turn ON the power

supply.

Press and hold the power switch for
approx. 1s.

"Shutting down. Please wait. Power
will turn OFF automatically" will be
displayed in the control panel, and the
power switch LED lamp will flash on an
approx. 1-s cycle.

Wait a moment, and the power

supply for the device will turn OFF
automatically, and the LED lamp on the
power switch will turn OFF.

(1t Note)

® Press and hold the power switch for 5s min. to force-turn
OFF the power supply. Use only if a problem has occurred.
For device problems, see "Troubleshooting/Daily
Maintenance Manual".

In the following cases, use the following
procedure to turn OFF the main power supply.

If not using the device for long periods over
holidays or during travel, etc.

If mounting optional or maintenance products.
If moving the device.

If implementing device repairs or inspections,
etc.

Press and hold the power switch for
approx. 1s.

"Shutting down. Please wait. Power
will turn OFF automatically" will be
displayed in the control panel, and the
power switch LED lamp will flash on an
approx. 1-s cycle.

Wait a moment, and the device power
supply will turn OFF automatically, and
the LED lamp on the power switch will
turn OFF.

2 Turn the main power supply switch to
the OFF (O) position to turn OFF the
power supply.




Test Printing Using the Printer Only

Test Printing Using the Printer Only

Check that printing is actually enabled using the printer only. Check by printing the device setup and
setup details, which enable the status to be checked. (Printer information.)

® Print the "printer information" on A4 size paper. Set A4 size paper in the paper feed tray.

Reference

® See “Turning ON the Power Supply” (P.51) for how to turn ON the power supply.

1 Set A4 paper in tray 1.

Check that the standby screen is
displayed in the liquid crystal panel.

Ready To Print

100% 100% 100% 100%

U

Yellow Magenta Cyan Black

Press the [Fn] key.
The numerical values input screen will
be displayed.

Press [1], [0], [0], and then press the
[OK] button.

(" HELP

@ MENU ON@E @

ABC  DEF

(&) (5 (6)

GHI JKL  MNO

6 (7)(8)(9)

PQRS _Tinv  WXYZ

When [Execute] has been selected,
press the [OK] button.

Tl v Configuration

(L) Use Online button to retum to s...

The printer information will be
displayed.
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Test Printing Using the Printer Only

Printer Information

Confiaurati oo

A0 A 112U 8520 012102 A 1275187

During test printing, the following device setup

details (printer information) will be printed. £
s =
® Use the printer information to check the functions that T g
are currently usable, the settings table, the software and E=ET =S
hardware versions built into the device, and the print EEEer ==
quantity, etc. T A
® The printer information described here is a sample. The gw;'"‘“”” i
printer information printed by your device may differ in =
places. =T -

o . e

Reference

A . ! ® You can also print function reports and demo pages, etc.
S Check here if an option For details, see "Advanced".
(expansion tray unit or
built-in HDD) is
mounted.
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Connecting the PC

Connecting the PC

This section explains how to connect the device to a PC.

Connecting to PC

For Windows

For Macintosh

Connecting via a
network

Connecting via USB

Connecting via a network
Connecting via Connecting via
EtherTalk Bonjour/Rendezvous

Connecting via USB

—

«

\ 4

Connecting the cables

Turning ON the device
power supply

«

Setting the IP address
in the device

«

Connecting the cables

«

Turning ON the device power supply

“ |«

Enabling the device
EtherTalk

«

Disablin \Y

Q
[a
(¢}

3
9]
a
)

ce sleep

«

Turning ON the PC power supply

“ ¢

Setting the IP
address, etc., in the

«

Setting EtherTalk in
the PC

«

Installing the printer drivers

— | |e

¢ — | —— e

¢ | — | | —

Turning ON the device
power supply

Adding devices to the PC

«

“ |«

«

€ ¢ — l— l¢|¢

Checking operations from the PC

(See “3. Printing”)
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Connecting the PC

Operating Environment

The device is compatible with the following operating systems (0S).
® Windows 8.1/Windows 8.1 (64-bit version)*

® Windows 8/Windows 8 (64-bit version)*

® Windows Server 2012 R2

® Windows Server 2012

® Windows 7/Windows 7 (64-bit version)

® Windows Vista/Windows Vista (64-bit version)

® Windows Server 2008 R2

® Windows Server 2008/Windows Server 2008 (x64 version)

® Mac OS X 10.3.9 to OS X 10.9

*: Only desktop mode is compatible for Windows 8.1 and Windows 8.

Printer Driver Types

The following types of printer driver can be installed.

® Windows
Type Explanation
PS Applies to the printing of documents that include PostScript fonts and EPS
data.
PCL Applies to the printing of business documents.
XPS Applies to printing from applications that support XPS.

® Mac OS/Mac OS X

Type Explanation

PS Applies to the printing of documents including PostScript fonts and EPS data.
Can also be used for regular printing.

(! Note)

® Descriptions may differ depending on the printer driver, and Windows or Mac OS version.
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Connecting Cables

Connect the device to a PC or network.

The device is equipped with the LAN (network)
interface connectors and USB interface
connectors as standard. Connections can be
made to the network directly using LAN cables,
and to the PC using USB cables.

Connecting Using LAN Cables

Connecting the device to a network such as
LAN (Ethernet*), etc., enables the device to

be shared by all the PCs on the network. This
system can be used by OS such as Windows or
Mac, etc.

*: The device is equipped with network interfaces compatible
with 10BASE-T/100BASE -TX/1000BASE-T as standard.

Macintosh

Windows

]
lo
l

B Preparations

\S

LAN cable Hub

R
NN

(! Note)

® LAN cables and hubs are not enclosed with the device.
Prepare LAN cables (category 5 or greater, twist pair
cable, straight) and hubs as necessary.

® The setup must be changes if using with 1000BASE-T
as the factory default settings are "Gigabit network:
Disabled" in the administrator setup menu.
Setup method: In the control panel, select [Admin
Setup]> Enter the password> [Network Setup]> [Gigabit
network]> [Enable].

m Connecting LAN Cables

Connect the LAN cable to the LAN
(network) interface connector (D).

Connect the other end of the LAN cable
to the hub connector ().

LAN cable LAN (network)
interface

Connector




Connecting the PC

Connecting Using USB Cables

Connect the device and PC using USB cables.

USB cable

USB cable

(! Note)

® USB cables are not enclosed with the device. Prepare USB
cables with USB2.0 specifications, length 2m max. as
necessary.

® If connecting using USB2.0 Hi-Speed mode, use a USB
cable with Hi-Speed USB2.0 specifications.

m Connecting USB Cables
(! Note)

® If the printer drivers are not installed on the PC, remove
the USB cable fromthe PC, and first install the printer
drivers. (page 65)

1 Pay attention to the connector
orientation, and connect the square end
of the USB cable to the Printer (D).
Connect the other, flat end to the PC ().

USB interface
connector

USB cable

(1t Note)

® Be careful not to insert the USB cable into the LAN
(network) interface connector. Doing so may cause a
printer malfunction.

® Do not insert the USB cable when the PC or device power
supply is ON. Doing so may cause a printer malfunction.

® Set the device USB baud rate using the control panel
according to the USB port baud rate (speed) mounted
to the PC. For the control panel, see “Control Panel
Appearance” (P.25).



Connecting the PC

Installer Printer Drivers

(Windows)

Network Connections

To connect the Windows PC and device to the
network, first set the device IP address. Next,
install the printer drivers on the PC.

If there are no DHCP or BOOTP servers on the
network, it is necessary to set the IP address on
the PC and device manually.

Further, it is also necessary to set the IP address
in the PC and device manually if instructed to
set a specific IP address determined by the in-
house network administrator, provider, or router
manufacturer.

m Setup Flow
|Turning ON the device power supply |

«

|Setting the IP address in the device |

«

|Turning ON the PC power supply |

«

|Setting the IP address, etc., in the PC |

«

|Insta|ling the printer drivers |

(1t Note)

® If the IP address is incorrect, the network may go
down, or internet connections be disabled. Check the IP
addresses that can be set in the device with your in-house
network administrator or internet service provider.

® The server on the network (DHCP, etc.) depends on the
network environment in use. Check with your in-house
network administrator, internet service provider, or router
manufacturer.

® Setup requires computer administrator privileges.

® In "Setting Up", the operating procedure described is for
Windows 7 unless otherwise specified. The screens and
operating procedure may differ depending on the OS.

m Setting the IP Address in the
Device Using the Control Panel

® If configuring using a small scale network that connects
the device to a single PC, set the following IP address
(conforming to RFC1918).

® PC
- IP address: Any from 192.168.0.1 to 254
- Subnet mask: 255.255.255.0
- Default gateway: Not used
- DNS server: Not used
® Device

- IP address setup: Manual from 192.168.0.1 to 254
(Select a different value fom the PC.)

- Subnet mask: 255.255.255.0
- Default gateway: 0.0.0.0
- Network size: Small scale

This section explains the following settings as an
example.
IP address: 192.168.0.3 (PC)
192.168.0.2 (Device)
Subnet mask: 255.255.255.0

Gateway address: 192.168.0.1

Press either the scroll button A or v
on the control panel to display the
"Functions" screen.

Functions 1/2 Page
n Configuration

Print Information

B Print Secure Job

a Menus

BAdmin Setup

a E] Print Statistics

O Use Online button to return to standby screen...

Press the scroll button ¥ several times
to select [Admin Setup], and then press
the [OK] button.

Functions 1/2 Page‘
n Configuration

B Print Information

B Print Secure Job

a Menus

B E Print Statistics

O Use Online button to return to standby screen...




Connecting the PC

Use the 10-key pad to enter the
administrator password.

The default factory-set password is
the first 10 digits of the serial humber.
Press the [OK] button after entering
each individual character.

Enter Password

axaxzx
(6 -12 digits )

O Use Online button to return to standby screen.

4 Press the [OK] button.

Check that [Network Setup] has been
selected, and press the [OK] button.

Admin Setup 1/2 Page
B usB Setup

Print Setup

@ s Setup

B PcL setup

@ xps setup

() Use Online button to return to standby screen

Press the scroll button ¥ several times
to select [IP Address Set], and then
press the [OK] button.

Network Setup 1/2 Page
@ Tcr/1P

) NetBIOS over TCP

B EtherTalk

B 1Pv4 Address

@ subnet Mask

() Use Online button to return to standby screen

/

If setting the IP address manually, press
the scroll button ¥ to select [Manual],
and then press the [OK] button.

->Go to Step 8

1/1 Page

() Use Online |© Use Online button to return

If acquiring the IP address automatically,
check that [Auto] has been selected, and
then press the [OK] button.

—->Go to Step 14

Netwo IP Address Set
|1 pel YA ) v Auto

B NetBIOS 0| Manual
EtherTalk

) Use Online |© Use Online button to return

Press the scroll button ¥ several times
to select [IPv4 Address], and then click
the [OK] button.

Network Setup 1/2 Page
@ Tcp/1P

B NetBIOS over TCP

E) EtherTalk

@ 1P Address Set

@ Subnet Mask

() Use Online button to return to standby screen

Use either the scroll buttons AW¥ or the
10-key pad to enter the first 3 digits
of the IP address, and then press the
[OK] button. Enter the next 3 digits

in the same way. When all entries are
complete, press the [BACK] button.

To move to the next box, press the [OK]
button.

@ cr/1p
) NetBIOS o
EtherTalk
B3 1P Address

IPv4 Address
XXX XXX XXX XXX A]

@) Use Online §© Use Online button to return




Connecting the PC

Press the scroll button ¥ to select
[Subnet Mask], and then press the [OK]
button.

1

Network Setup 1/2 Page
@ Tcp/1P

B NetBIOS over TCP

E) EtherTalk

@ 1P Address Set

@ 1Pv4 Address

G Subnet Mask

() Use Online button to return to standby screen

Enter the subnet mask in the same way
as the IP address. When all entries are
complete, press the [BACK] button.

1

Subnet Mask

XXX XXX XXX XXX

) Use Online §© Use Online button to return

Press the scroll button ¥ to select
[Gateway Address], and then press the
[OK] button.

1

Network Setup 2/2 Page
@ Gateway Address

(© Use Online button to return to standby screen

Enter the gateway address in the same
way as the IP address. When all entries
are complete, press the [BACK] button.

1

Gateway Address

XXX XXX XXX XXX

() Use Online | Use Online button to return

1

Press the [ON LINE] button to complete
the network setup.

(" HEeLP M — N
ENU N LINE
O 256
, CANCEL
OWER SAVE O PQRS TUV WXYZ
@
ATTENTION Fn CLEAR,
TS

Ready To Print

100% 100%

anl

Yellow Magenta Cyan Black




Connecting the PC

H Setting the IP Address in the PC Select [Internet Protocol Version 4
(t ote) (TCP/IPv4)], and click [Properties].
® If the IP address has already been set in the PC or is (T Local Are Connection Properties =

acquired automatically, go to “Setting the IP Address in =

the Device Using the Control Panel” (P.59). Hetwoddng

Connect using:
1 Turn ON the PC power supply to start IE oD PRO/GTNT ok Conacten
Windows.

This connection uses the following items:
¥l % Client for Microsoft Networks
QoS Packet Scheduler
™ JBFile and Printer Sharing for Microsoft Networks

Click [Start], and select [Control panel].

& Intemet Protocol Version € (TCP/IPvE)
2 Intemet Protocol Version 4 (TCP/IPv4)

. . Wl s Link- iSCOVe iver
3 Click [View network status and tasks]. ) Lo Tonloy Dcovey Fecsndor

Adje ttings. S — |

Description

Transmission Control Protocol/Intemet Protocol. The default
wide area network protocol that provides communication
across diverse interconnected networks.

Enter the IP address, Subnet mask,
Default gateway, and DNS server, and

click [OK].
|
] . ' Internet Protocol Version 4 (TCP/IPwd) Properties [7 =]
Click [Local Area Connection], and then
) ) ) "L I A General
click [Properties] in the "Local Area oo et st o ot e e s
Connection Status" window. for the spproprate I settgs. T e erk admnst
I . Local Area Connection Status ] (©) Obtain an IP address automatically
z o == @ Use the following IP address:
General IP address: 192,168, 0 . 3
Connection Subnet mask: 255.255.255. 0
1Pv4 Connectivity: Intemet Default gateway: 192.168. 0 . 1
IPv6 Connectivity: No Internet access
Media State: Enabled Obtain DNS server address automatically
Duration: 01:48:28 @ Use the following DNS server addresses:
Speed: 1.0 Gbps
Preferred DNS server: 192 . 168 . 3 .220
Alternate DNS server:
Activity [ validate settings upon exit
Sent — —  Received
o K ==
Bytes: 38,518 | 57,162
_ -%Memo
(l B Properties ]l (4 Disable || Diagnose ]
® If acquiring the IP address from the DHCP server
automatically, select "Obtain an IP address
automatically”, and do not enter an IP address.

® Do not enter if not using a Default gateway or DNS
server.

Close the "Local Area Connection
Properties" window.



Connecting the PC

m Setting the Device Network 14 Click [Device Network Setup].
e
® If you have set up the IP address for this printer by

following Steps 1~14 in “Installer Printer Drivers SRS S
(Windows)” (P.59), then skip this section.

Custom Install g\?g‘%zgsgfzg e
Download drivers from IntoPrint ] )
support site. the "AutoPlay" window is

displayed, click [Run Setup.exe].

When the "User Account Control"
window is displayed, click [Yes]. [CREZEEET R ) [ o ] (e

1 Read the "Software License Agreement" 1 The printer search will start. Select the
thoroughly, and click [Agree]. device from the table when the printer

Read the "Environmental advice for has been detected, and click [Next].
Users", and click [Next]. —— <
Pre-Installation Check X Review your installation settings.
Click "Next".
fothe drver fon Wizard Device 1P Address Pirter name.
. You will be guided through the steps for : Searching.

installing drivers and other software for your

device.

Before you begin, please check the
following:

.
A
i i AlntoPrint .
ON, connected and have the e
) corect IP address and other settings. top Sear
AIntoPrint SNHP Seing

For devices connected localy such as wih a USB cable

m{i= )= = 1 Enter the network setup information,

and click [Setup].

12 Set the printer model to be set, and - S
click [Next].

Device Network Setup

Installation settings x Please specify the network information for device ., and click [Setup)
Review your installation settings. IP Address Settings

Auto Setting
e et the powerand Setto automaticllyootan P adaress.

nnnnn

© Manual Setting
SP1360(FCLE)
[ IntoPsrt SP1360S(PCLE)
[ IntoPint SP1360W(RCLE)

Screen in“Detaied informaton-.

adaress dentfcation numer

‘ Detailed information

Gateway set on the device

| IP Address St sed to identify the IP address
[ k
AIntoPrint
somnet sk E o
Default Gateway “

[ wenusetecton

<Back Next > Cancel Help

1 Enter the network setup password, and
click [OK].

Setup @

Enter your password into [Password] and click [OK].

1 Select [Network connection], and click
[Next].

Choose installation type X

Please choose an installation type.

Password sesese

Selected device's MAC Address : 00:25:36:06.00:84

The defauli password is the last 6 alphanumerical digits of the
Easy Installation (Local) ethermnet address.

AIntoPrint

Custom Installation




Connecting the PC

m Installing Printer Drivers Select the printer model to be used,

i and click [Next].
1 Check that the device and PC are
connected, and that the power supply is prNm— .
turned ON.

ea
[ intoPrnt SP13603(PCLE)
Reference [ ntoPrrt SP1360W(PCLE)

® “Connecting Using LAN Cables” (P.57)

Review your installation settings.

se search again after checking the power and
of devices.

AlntoPrint
Download the print driver from

IntoPrints support site.

<Ba (:| Next > )ancei Helo

Run Setup.exe
Select [Network connection], and click
[Next].

Choose installation type X

When the "User Account Control"
window is displayed, click [Yes].

Please choose an installation type.

Read the "Software License Agreement", G
and click [Agree].

Gr B LWON

% Easy Installation (Local)

EIntoPrint

Custom Installation

|:<mﬁ o> )cm Hoo

and Licensee accepts, a
Itiple computers which

The printer search will start. When the
printer has been detected, select the
device from the table. Click [Next] to
start the installation.

Installation settings X
Review your installation settings.
Click "Next".
Device IP Address Printer name:
‘Searching.

Read the "Environmental advice for
Users", and click [Next]. 2intoPri |

%
Pre-Installation Check X Stop Search
SNP Setting.

to the driver i ion Wizard

[ itoPrit SP1360(PCLE)
[ itoPrit SP1360S(PCLE)
[ ItoPrint SP1360W/(PCLE)

“You will be guided through the steps for
installing drivers and other software for your

E‘%};‘gmmp-easemecme 1 When the installation has finished, click
[Exit].

For devices connected to a network

and have the

ON,
FIntoPrint <" ndanersenns

,,,,,,,,,,,,,,,

For devices connected localy such as wih a USB cable:

‘The device must be switched OFF and not connected to your computer.

(=) e




Connecting the PC

1 Select [Start]> Search [Printers and
Scanners].

Best match

% Printers & scanners
Syt setings
Setings
Printers & scanners
 Add aprinter or scanner > System settings

o Change

lor
ings for displays,

o open
& Let Windows manage my defaut
printer

Get quick help from web

Search the veb.

O Printers - sce web resits >

Changing piner status

1 Check that the IntoPrint SP1360 icon is
displayed.

Left-click the IntoPrint SP1360 icon and
select Manage the menu, and check
that all the printer drivers that have
been installed are displayed in the sub-
menu.

@  IntoPrint SP1360(PCL6)

Manage your device

This device has a few different functions. Pick one to manage settings
for that function.

IntoPrint SP1360(PS)

IntoPrint SP1360(PCL6)

Reference

® For how to print from the PC, see “Printing from Trays”
(P.89).

USB Connections

(1t Note)

® Check that the device power supply is turned OFF.

® Setup requires computer administrator privileges.

® This section described the operating procedure for
Windows 7 unless otherwise specified. The screens and
operating procedure may differ depending on the OS.

m Setup Flow
|Turning ON the PC power supply |

\ 4

|Insta|ling the printer drivers |

\ 4

|Turning ON the device power supply |

1 Turn ON the PC power supply to start
Windows.

® When the device power supply is turned ON, the
"Add new software wizard" may be displayed in the
screen. If this happens, click "CANCEL", and then
turn OFF the device beore proceeding to the next
step.

2 Download driver from IntoPrints support
site.

3 When the "User Account Control"
window is displayed, click [Yes].

4 Read the "Software License Agreement",
and click "Agree".
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Read the "Environmental advice for When the following screen is displayed

Users", and click [Next]. during the installation, connect the

< device and PC using a USB cable, and
o the dvor instaliation Wisard then turn ON the device power supply.

. You will be guided through the steps for

] " g Installing... X
installing drivers and other software for your
device. N ~
Before you begin, please check the 50 o B drivers and
following: . Step 1. With the device powered off, connect your device to your
computer.
For devices conneced to a netnork Step 2 Switch on your device.
ON, and havethe . o
comect IP address and other settings.
AlntoPrint -

"%
“"

For devices connected localy such as wih a USB cable:

‘The device must be switched OFF and not connected to your computer.

BINtoPrint 1 the screen docs not change when you comect the device, cick
a( )cm = I o et o i o

Install using another port

Select the printer model to be used,

and click [Next].

B ) ® If the display does not change even when the device
is connected, click [Install using another port].

Review your installation settings.

| g e creeatheponrane Select the port to which the device is connected
|| et e using the "Printer port" screen, and click [Next].

[ Intorrt SP1360W(PCLS)

Printer port X

Please select the port you want your printer ta use

_#IntoPrint

Port Descrption Printer name

Virtual prrter port for USB__IntoPrint SP 1
FILE: Local Pott

e m(] et ):m ey g B

_#IntoPrint

Select "USB connection", and click
[Next].

Choose installation type X

< Back Next > Cancel Help

Please choose an installation type.

When the installation has finished, click
Easy Installation (Network) [ E X i t ] Il

Installation complete

Easy Intalation (Local) ~ Installation complete.To end click "Finish™.

iIntoPrint

| You can change the defaut privter from the list below or change the defautt
| seffings by opening the driver Properties

Custom Installation

IntoPrint SP1360 Fail to get printer option

sl o= b

#IntoPrint [ —

< Back Finish Cancel Help
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10 Select [Start]> [Devices and Printers]. 1 Check that the IntoPrint SP1360 icon is
displayed.

— — Right-click the IntoPrint SP1360 icon

o T and select and item from the menu,

& i pis & scomes and check that all the printer drivers

o that have been installed are displayed

@mm in the sub-menu.

B @ IntoPrint SP1360(PCL6)

Changing prnter status

Manage your device

This device has a few different functicns. Pick one to manage settings
for that function.

T

IntoPrint SP1360(PCL6E)

Reference

® For how to print from the PC, see “Printing from Trays”
(P.89).

If Setup Fails

If setup fails using either a network or USB
connection, see the enclosed "Troubleshooting/
Daily Maintenance Manual".

This manual explains the possible causes of the
setup trouble and the countermeasures.
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Installing Printer Drivers :hsettup F'°V‘; Siter demend
- e setup procedure may differ depending on
(MaC|ntOSh) the print method.
Bonjour/
Network Connections EtherTalk Rendezvous
. . Turning ON the power Turning ON the power
To connect Mac OS X and the device via a supply supply

network, install the printer drivers on the

computer, and then set the device as a network *
printer.
Enabling the device
. - EtherTalk
m Deciding the Print Method
(Protocol) +
There are two printing methods from Mac OS X: — -
Using EtherTalk, and using Bonjour/Rendezvous. z‘gg:“ng device sleep
Print method
(Protocol) Features +
EtherTalk Uses functions mounted Turning ON the PC power [Turning ON the PC power
as standard to OS X supply supply
10.3 to 10.5.
Bonjour Use this with TCP/IP *
Rendezvous networks.
Setting EtherTalk in the
PC
Installing the printer Installing the printer
drivers drivers

«
«

Adding devices to the PC [Adding devices to the PC

«

¥

Go to “Using EtherTalk”.  Go to “Using Bonjour
(Rendezvous)” (P.72).

(! Note)

® Upgrading the Mac OS X or printer driver version may
result in differences from the description in the manual.

® Disable all anti-virus software before starting the setup.
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H Using EtherTalk

QEnable EtherTalk using the control panel,
and disable sleep mode

If connecting to a network using EtherTalk, it

is necessary to enable EtherTalk in the printer,

and disable sleep mode. Next, install the printer

drivers in the computer.

Reference

® People using Bonjour go to “Using Bonjour (Rendezvous)
(P.72).

”

Press either the scroll button A or v
on the control panel to display the
"Functions" screen.

Functions 1/2 Page
n Configuration

Print Infermation

B Print Secure Job

a Menus
B E|Admin Setup
B E]Print Statistics

(0) Use Online button to return to standby screen. ..

Press the scroll button ¥ several times
to select [Admin Setup], and then press
the [OK] button.

Functions 1/2 Page‘
n Configuration

g Print Information

a Print Secure Job

ﬂ Menus

B B Print Statistics

(0) Use Online button to return to standby screen...

3 Use the 10-key pad to enter the
administrator password.

The default factory-set password is
the first 10 digits of the serial humber.
Press the [OK] button after entering
each individual character.

Enter Password

i*****
(6 - 12 digits )

O Use Online button to return to standby screen.

4 Press the [OK] button.

Check that [Network Setup] has been
selected, and press the [OK] button.

Admin Setup 1/2 Page
B} usB Setup

Print Setup

@ rs setup

B PcL Setup

@ xPs Setup

() Use Online button to return to standby screen

Press the scroll button ¥ several times
to select [EtherTalk], and then click the
[OK] button.

Network Setup 1/1 Page
@ Tcp/1P

B3 NetBIOS over TCP

@ 1P Address Set

B 1Pv4 Address

@ subnet Mask

O Use Online button to return to standby screen

Press the scroll button ¥ to select
[Enable], and then press the [OK]
button.

Netwo EtherTalk
1 RrelZAA ) v Enable
P NetBIOS offJ Disable
E) EtherTalk

@ 1P Address

1/1 Page

@) Use Online @ Use Online button to return

Press the [BACK] button to display the
"Network Setup" screen.

Network Setup 1/2 Page
@ ce/1pP

B3 NetBIOS over TCP

EtherTalk

@ 1P Address Set

B 1Pv4 Address

@ subnet Mask

() Use Online button to return to standby screen
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Press the [BACK] button to display the
[Admin Setup] screen.

Admin Setup 1/2 Page
B usB Setup

Print Setup

@ Ps Setup

B PcL setup

@ xps setup

() Use Online button to return to standby screen

Press the scroll button ¥ several times
to select [Power Setup], and then click
the [OK] button.

1

Admin Setup 212 Pagﬂ
n Panel Setup
Time Setup

a Others Setup
Settings
B Change Password

O Use Online button to return to standby screen...

Press the scroll button ¥ to select

1

Power Setup 141 Page

n Power Save

B Auto Power Off

() Use Online button to return to standby sereen.

Press the scroll button ¥ to select
[Disable], and then click the [OK]
button.

1

() Use Online button to return to s...

[Sleep], and then click the [OK] button.

Press the [ON LINE] button to return to
the standby screen.

1

=S MENU ON LINE )
O ()

O

Ready To Print

ATTENTION
TS

100% 100%

Al

Magenta Cyan Black
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0 Installing the printer drivers on the computer

1

CO~NJO On

Check that the device and PC are
connected, and that the power supply is
turned ON.

Reference

® “Connecting Using LAN Cables” (P.57)

Download the driver from IntoPrints
support site.

Double-click [Driver]> [Installer for OS
X10.5-10.10.pkg].

S
Installer for
05X10.5-10.9.pkg

Enter the Mac OS X administrator
password, and click [Install Software].

Installer is trying to install new software. Type
- your password to allow this.

Name: 3000000 |

Password: |~ ------- |

-
e —

Finish the installation by following the
instructions displayed on the screen.

Select [System Preferences] from the
Apple menu.

Click [Print & Scan].
Click [+].

Click [AppleTalk].

Character Set: Japanese (Mac OS)

Name: No Selection
Location: No Selection

Print Using:

Add

Select the printer, and check that
[IntoPrint SP1360(PS)] is displayed in
[Print Using].

80e =

Local Zene O 5P1350 ]
Character Set:  Japanese (Mac OS)
Name: SP1360
LOCatiON
PrintUsln' [sP1360 i+ ]
(T
Add )
4

10 Click [Add].

1 Check that [SP1360] is displayed as
added to the printer list, and close the
[Print & Scan] screen.

800 Print & Scan

(<] [Showai | .
——J OKI C931(PS) — OKI C931(PS)
="

| OpenPrint Queve... |

| Options & Supplies... |
Location: 192.168.0.2
Kind: OKI CO31ES)
Status: Idle

[_| Share this printer on the network | Sharing Preferences...

Default printer: | Last Printer Used

Default paper size: | A4

N ~
Ij Click the lock to prevent further changes. @

(! Note)

® If [IntoPrint SP1360(PS)] is not displayed correctly
in [Kind], click [-] to delete the device from
[Printers], and repeat Steps 7 to 10 again.
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m Using Bonjour (Rendezvous)

QInstalling the printer drivers on the

computer

1

Co

Check that the device and PC are
connected, and that the power supply is
turned ON.

Reference

® "“Connecting Using LAN Cables” (P.57)

Download the driver from IntoPrints
support site.

Double-click the IntoPrint icon on the
desktop.

Double-click [Driver]> [Installer for OS
X10.5-10.10.pkg].

o
Installer for
05X10.5-10.9.pkg

Enter the Mac OS X administrator
password, and click [Install software].

(‘1 Installer is trying to install new software. Type
o your password to allow this.

T 1
Name: |xxxxxxx

Password: ] -------- ]

f|

Finish the installation by following the
instructions displayed on the screen.

Select [System Preferences] from the
Apple menu.

Click [Print & Scan].

Click [+], and select [Add printer or
scanner].

9 Click [Default].

1

Add

=] o

MName: M Kind
OKI-C931-0600A2 Bonjour

Name: No Selection
Location: No Selection

Use:

Add

Select the printer displayed as [Bonjour]
in [Kind], and check that [IntoPrint
SP1360(PS)] is displayed in [Use].

The name of the printer will be
displayed in the format "IntoPrint-
SP1360-(last 6 digits of MAC address)".

800 Add

2-28 - i

ame & Kind

OKI-C931-0600A2

Name: OKI-C931-0600A2

Location: |
u ([ OKI CO31(P5) : |)
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1

Click [Configure] in the next screen.

If the optional expansion tray unit has

been mounted to the device, you can
change the number of trays.

If an optional built-in HDD has been

mounted, enable the [Hard Disk] check

box.

008 Add

e £5 B2

Fax P Windows Search

| @Emg ' Setting up 'OKI-C931-0600A2..."

\

RS SSSSSSSSRS SRR ey

Setting up the device...

' Configure |' Cancel |

Name: | OKI-C931-0600A2

Location:

Use: | OKI C931(PS)

Add |
008 Add
{Q N % a i
t| Fax 1P Windows i Search
I ﬁ Setting up 'OKI-C931-0600A2..." i
% ' Make sure your printer's options are accurately shown here
y 50 you can take full advantage of them.
Available Trays: [ 4 ]
& Hard Disk
[ caneel | k]
|
[ Add |

1 Check that [IntoPrint-SP1360-(last 6
digits of MAC address)] is displayed as
added to the printer list, and close the
"Print & Scan" screen.

800 Print & Scan

: : -_ShrmAIi (cL )

= OKI-C931-0600A2

[ Open Print Queue... |

A

{_Opmnsghp_piies... |

Location:
Kind: OKI C31(PS)

Status: Idle

(] Share this printer on the network | Sharing Preferences...

Default printer: | Last Printer Used 3

Default paper size: | A4 $)
ol @
Click the lock to prevent further changes. )

(! Note)
® If [IntoPrint SP1360(PS)] is not displayed correctly

in [Kind], click [-] to delete the device from [Printer],
and then repeat Steps 8 to 11 again.
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USB Connections 5 Enter the Mac OS X administrator

To connect Mac OS X and the device via USB, password, and click [Install software].
install the printer drivers on the computer, and

then set the device as a USB printer. (), e e g o il s st Tyme
. Setup FIOW Nime:;xxxxxxx l
Password: | esssesse
Turning ON the power supply
| i |
Finish the installation by following the
[Turning ON the PC power supply | instructions displayed on the screen.

«

Select [System Preferences] from the
Apple menu.

|Insta||ing the printer drivers |

\ 4

|Adding devices to the PC |

(1 Note)

® Upgrading Mac OS X or the printer driver versions may
cause differences from the description in the manual.

Click [Print & Scan].

6
/
8 Click [+].
9

Select the printer displayed as [USB] in

[Kind].
® Disable all anti-virus software before starting the setup.
80e Add
1 Check that the device and PC are )'&%;i?: "? wm < = ‘
connected, and that the power supply is = -
turned ON.
® "Connecting Using USB Cables” (P.58)
2 Download the driver from IntoPrints
support site. e
Use: | OKI C931(PS)
3 Double-click the IntoPrint icon on the
desktop. Cade )
4 Double-click [Driver] > [Installer for OS Check that [Intofrint"SP1360] is
X10.5-10.10.pkg]. c[j'lo‘sdpdl?yed in the "Add" screen, and click

L
Installer for
05X10.5-10.9.pkg
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1 Click [Configure] in the next screen. 1 Check that [IntoPrint SP1360] is
If the optional expansion tray unit has displayed as added to the printer list,
been mounted to the device, you can and close the "Print & Scan" screen.
change the number of trays. eo0 RO
] o EE=TN Q
If an optional built-in HDD has been
mounted, enable the [Hard Disk] check Gy T
box \ [ Open Print Quese... |
n (\ 0 sl Location:
{9 NG (Q Kind: OKI C93L(PS)
| Fax P Windows Search SanERkE
| aEmg  Setting up 'OKI DATA CORP C931..." i () Share this printer on the network | Sharing Preferences...
P ==
Default printer: | Last Printer Used )
Cancel | Default paper size: | A4 &
I!] Click the lock to prevent further changes. ‘\?)
Name: | OKI DATA CORP €931
Location: | 201302-018 ] ® For how to print from the PC, see “Printing from Trays”
Use:| OKI C931(p5) 3 (P.89).

) If Setup Fails

v If setup fails using either a network or USB
Add connection, see the enclosed "Troubleshooting/
(a Daily Maintenance Manual".
Search
-I et oy B ra | This manual explains the possible causes of the
fi',- S setup trouble and the countermeasures.
¥ s0 you can take full advantage of them.
Available Trays: (4 ¢
# Hard Disk
| Cancel |

[ Add |
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Addil‘lg OptiOns QAdding the Built-in HDD

Use the following procedure to set the printer 4 If using a network connection, click

drivers if an optional expansion unit or built-in [Get installed options automatically] in
HDD have been mounted to the device. [Installable Options].
If using a USB connection, select
B Windows PS Printer Drivers [Installed] in [Hard Disk].
1 Click [Start], and select [Devices and o ST Pepet 8
General Sharing Ports  Advanced Color Management Securty Device Settings

Printers].

= IntoPrint SP1360(PS) Device Settings
#2| Form To Tray Assignment
. . . @? Fent Substitution Table
2 Right-click the IntoPrint SP1360 - Avallable PostScript Memry: 2767 KE
. . N e Qutput Protocol: ASCI
icon, and select [Printer properties]. Send CTRL-D o Each o o

Send CTRL-D After Each Job: Yes

([IntoPrint SP1360(PS)] if installing Comer Gy TottopossrGorte
multiple printer drivers.) 4 Euo Carrency Symbeol to PostSaip Fon

Add Euro Currency Symbol to PostScript Fonts: No

Job Timeout: 0 seconds

Wait Timeout: 300 seconds

Minimum Font Size to Download as Outline: 100 pixel(s)
e Maximumm Font Size to Download as Bitmap: 600 pixel(s]

=-ff% Installable Options

( EEET-. )

3 Select the [Device Settings] tab.

QA Adding an Expansion Tray Unit

4 If using a network connection, click Cacel | [ oply
[Get installed options automatically] in

[Installable Options]. 5 Click [OK].

If using a USB connection, enter the
number of trays minus the multi-
purpose tray in [Available Trays].

For example, if three expansion trays
are mounted, the usable trays are trays
1/2/3/4, so enter "4",

E;q IntoPrint SP1360(PS) Properties *

General Shaing Ports  Advanced Color Management Securty Dsvice Settings

=8 IntoPrint 5P1360(PS) Device Settings
4] Form To Tray Assignment
8 Font Substitution Table
Auvailable PostScript Memory: 32767 KB
Qutput Protocol: ASCI
«.. S5end CTRL-D Before Each Job: No
Send CTRL-D After Each Job: Yes
Convert Gray Text to PostScript Gray: No
Convert Gray Graphics to PostScript Gray: Ne
~ Add Euro Currency Symbeol to PostScript Fonts: Mo
- Job Timeout: D seconds
Wait Timeout: 300 seconds
Minimum Fent Size to Download as Qutline: 100 pixel(s]
Maviesio Pont Cioe to Nownload as Bitmap: 600 pixel(s)

Print only encrypted data: No

Cancel Foply
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B Windows PCL Printer Drivers

1
2

3

Click [Start], and select [Devices and
Printers].

Right-click the IntoPrint SP1360

icon, and select [Printer properties].
([IntoPrint SP1360(PCL6)] if installing
multiple printer drivers.)

Select the [Device Options] tab.

QO Adding the Built-in HDD

4

If using a network connection, click [Get
Printer Settings].

If using a USB connection, enable the
[Printer Hard Disk] check box.

QO Adding an Expansion Tray Unit

4

If using a network connection, click [Get
Printer Settings].

If using a USB connection, enter the
number of trays minus the multi-
purpose tray in [Installed Paper Trays].

For example, if three expansion trays
are mounted, the usable trays are trays
1/2/3/4, so enter "4".

@ IntoPrint SP1360(PCLE) Properties *

General Sharng Pois  Advanced Color Management Securty Device Options

Installed Options B T

Installed Paper Trayps: [5 =

Frinter Hard Disk

g
-
P
| ]
Jobtypes to print o
(@) Print any job types = /’|
() Print encrypted job anly

Job infarmation watemark, = d

] Only admiristrator autharizes changes

About.

oK I Cancel Apply

E;q IntePrint SP1360(PCLE) Properties s
General Sharng Ports  Advanced Color Management Securty Device Options
Installed Options = 7
Installed Paper Trays: § z
—
FA Printer Hard Disk w
4
A
o
Jobtypes to print i o
(®) Print any job ypes =V
() Print encrypted job only
Jab infarmation watermark | F |
[ Only admiristrator authorizes changes
About
I QK Cancel Apply

5 Click [OK].
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® Mac OS X PS Printer Drivers ® Memo

(! Note)

® This section describes the operations procedures for
Mac OS X 10.8 unless otherwise specified. Screens and
operations procedures may differ depending on the
version.

Select [System Preferences] from the
Apple menu.

Click [Print & Scan].

Select the printer, and click [Options
and Supplies].

CONY =

4 Select the [Driver] tab.

QA Adding an Expansion Tray Unit

Select the correct value for [Available
Trays], and click [OK].

| General m Supply Levels |

To take full advantage of your printer's options, confirm that they are accurately shown
there. For information on your printer and its optional hardware, check the printer's
‘documentation.

QAdding the Built-in HDD

5 Enable the [Hard Disk] check box, and
click [OK].

| _General Supply Levels |

To take full advantage of your printer's options, confirm that they are accurately shown
here. For information on your printer and its optional hardware, check the printer's
documentation.

Available Trays-[_4 =]

& Hard Disk

6 Click [OK].



Setting Up




Setting Up

- 80 -



Paper

This chapter explains the methods from setting the paper in the device to actual printing.

¢ Paper

Usable Paper Types

For high-quality printing it is necessary to use paper that satisfies conditions regarding quality,
thickness, paper finish, etc. If printing on paper not recommended by IntoPrint, thoroughly test the
print quality and paper traveling performance, etc., and check that there are no impediments before
use.

If using a (paper) medium that is curled or wrinkled before printing, print quality and paper traveling
performance cannot be assured.

o
=
3
(=g
3
«Q
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Paper

m Paper Types, Size, and Thickness

(! Note)
® Paper sources and output are restricted by paper type, size, and thickness.
Type Size unit: mm (inches) Thickness
Plain paper A3Nobi 328x%x453 GSM paper weight 52-360g/m? (ream
A3Wide 320%450 weight 45-309kg)
Paper under GSM paper weight 52 to
A3 297x420 64g/m’ (ream weight less than 45 to
A4 Wide 225%320 55kg) and GSM paper weight 320 to
A4 ssoe/m (e el 273 fosoom)
A5 148x210 (! Note)
A6 105%148 ® If the paper size settings satisfy the
B4 257x364 following conditions, print speed will be
B> 182x257 glaop\:\é?‘ds.ize: A6, A5; paper width 216mm
B6 128x182 (letter width) max.
B6 Half™ 64x182
Letter 215.9%x279.4 (8.5x11)
Legal (13 inch) 215.9%x330.2 (8.5x13)
Legal (13.5 inch) 215.9x342.9 (8.5x13.5)
Legal (14 inch) 215.9x355.6 (8.5x14)
Executive 184.2x266.7 (7.25%10.5)
Tabloid Extra 304.8x457.2 (12x18)
Tabloid 279.4x431.8 (11x17)
Statement 139.7x215.9 (5.5%8.5)
13x18 inch 330.2x457.2
16K (184x260mm) 184x260
16K (195%x270mm) 195%x270
16K (197%x273mm) 197x273
8K (260x368mm) 260%x368
8K (270x390mm) 270%x390
8K (273%394mm) 273x394
Custom™ Width 64 to 330 GSM paper weight 52-360g/m? (ream
Length 89 to 1321 weight 45-309kg)
Hagaki Hagaki 100x148 Japanese Postcard
Oufuku Hagaki 148%200 These can be used for Duplex.
4-Ren Hagaki 200%x296

*1: B6 half size cannot be used for Duplex.

*2: Paper with widths from 99.0mm to 330.0mm and lengths from 147 to 483.0mm can be used for Duplex.
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Paper

Type Size unit: mm (inches) Thickness
Envelopes® Younaga #3 120x235 Using GSM weight 85g/m? paper
Kakugata #6 162x229
Nagagata #3 120%x235
Nagagata #4 90x205
Nagagata #40 90x%x225
Yougata #0 120%x235
Yougata #2 114x162
Yougata #4 105x235
Kakugata #6 162x229
Kakugata #2 240%332
Kakugata #3 216%x277
Younaga #3 120%x235
Kakugata #8 119x197
Com-6 3/4 92.1x165.1 (3.625x%6.5) 24LB paper is used, with flaps firmly
Com-9 98.4x226.1 (3.875x8.875) creased
Com-10 104.8%241.3 (4.125x%9.5)
Monarch 98.4x190.5 (3.875x%x7.5) B
A2 Envelope 111.1x146.1 (4.375%5.75) §
A6 Envelope 120.7%165.1 (4.75%6.5) <
A7 Envelope 133.4x184.2 (5.25%x7.25)
DL 110%x220 (4.33x8.66)
C5 162x229 (6.4%9)
c4 229x324 (9%x12.8)
Labels A4 0.1 to 0.2mm
Letter
Glossy A4 210%x297
A3 297%420
A3Nobi 328x%x453
Partially Equivalent to plain paper. GSM paper weight 52-360g/m? (ream
printed paper weight 45-309kg)
Color paper Equivalent to plain paper. GSM paper weight 52-360g/m? (ream
weight 45-309kg)
Transparency |A4 0.1 to 0.125mm
Letter
Index Card® |Index Card 76.2x127 (3x5)

*: Duplex printing is not possible on envelopes, labels, transparencies, and index cards.
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m Setting the Paper Weight
Set the paper weight according to the ream weight of the paper to be used.

This step is not required for Media Weight (Auto), but in case of paper jam or decrease in printing
quality, manual setting is recommended.

Media Weight Ream weight

Ultra Light 14Ib < Media Weight < 17Ib
52g/m’ < Media Weight < 64g/m’®
45kg £ Media Weight < 55kg

Light 17Ib £ Media Weight £ 18Ib
64g/m? < Media Weight < 68g/m?
55kg £ Media Weight < 59kg

Medium Light 18lb < Media Weight £ 22Ib
68g/m’ < Media Weight < 83g/m’
59kg < Media Weight £ 71kg

Medium 221lb < Media Weight < 28lb
83g/m?> < Media Weight < 105g/m”
71kg < Media Weight < 90kg

Medium Heavy 28lb £ Media Weight < 32Ib
105g/m?” £ Media Weight £ 120g/m?
90kg = Media Weight = 103kg

Heavy 32lb < Media Weight £ 34Ib
120g/m? < Media Weight £ 128g/m?
103kg < Media Weight £ 110kg
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Ultra Heavyl 34lb < Media Weight £ 50Ib
128g/m? < Media Weight < 188g/m?
110kg < Media Weight £ 162kg

Ultra Heavy2 50Ib < Media Weight £ 57Ib
188g/m?* < Media Weight < 216g/m’
162kg < Media Weight = 186kg

Ultra Heavy3 57Ib < Media Weight £ 68Ilb
216g/m’ < Media Weight < 256g/m?
186kg < Media Weight £ 220kg

Ultra Heavy4 68lb < Media Weight £ 85Ib
256g/m? < Media Weight £ 320g/m?
220kg < Media Weight £ 275kg

Ultra Heavy5 85lb < Media Weight £ 96lb
320g/m? < Media Weight £ 360g/m?
275kg < Media Weight = 310kg

*: Manual paper weight setting is recommended when using media of Ultra Light or Ultra Heavy5.
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Paper

Paper Feed and Output Methods Selectable for Each

Paper type

O: Usable
X: Not usable

Type

Size

Settable tray

Output bin

Thickness

Multi-purpose

Tray 1

Trays
2to 5
(Optional)

Face-up | Face-down

Plain paper
(With
Duplex)

A3Nobi, A3Wide, A3,
A4Wide, A4, A5, A6,
B4, B5, B6, Letter,
Legall3, Legall3.5,
Legall4, Executive,
Tabloid Extra, Tabloid,
16K (184x260mm),
16K (195x270mm),
16K (197x273mm),
8K (260x368mm),
8K (270x390mm),
8K (273x394mm),
13"x18"

GSM 64 to 320 g/m?

Custom (Width 99 to
330mm, length 147
to 457mm)

GSM 64 to 320 g/m?

Custom (Width 64mm
min., less than 90mm;
length greater than
457mm to 483mm
max.)

GSM 64 to 320 g/m?

Plain paper
(With
1-sided
printing)

A3Nobi, A3Wide, A3,
A4, A5, A6, B4, B5,
B6, B6 Half, Letter,
Legall3, Legall3.5,
Legall4, Executive

GSM 52 to 320 g/m’

Tabloid Extra,
Tabloid, Statement,
16K (184x260mm),
16K (195x270mm),
16K (197x273mm),
8K (260x368mm),
8K (270x390mm),
8K (273x394mm),
13||X18||*1

GSM larger than 320
up to 360g/m? max.

Custom
(Width 90 to 330mm,
length 147 to 457mm)

GSM 52 to 320 g/m>

Custom (Width 64mm
min., less than 90mm;
length greater than
457mm to 1321mm
max.)

GSM 52 to 320 g/m?

Custom
(Width 64 to 330mm,
length 89 to 1321mm)

GSM larger than 320
up to 360g/m? max.
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Paper

Settable tray Output bin

Trays
Tray 1 | 2to 5 |Face-up | Face-down
(Optional)

Type Size Thickness Multi-purpose
tray

Postcard™ [Hagaki, Oufuku -
Hagaki 0] (0] 0] ) O
4-Ren Hagaki™

Envelope™ |Nagagata #3, Using GSM weight
Nagagata #4, 85g/m?’ paper
Nagagata #40,
Yougata #0, Yougata
#2 (C6), Yougata

#4, Kakugata #2,
Kakugata #3,
Kakugata #6™,
Kakugata #8, Younaga
#37

Com-6 3/4, Com-9, Uses 24Lb paper
Com-10, Monarch,
A2 Envelope, A6 0] X X 0] X
Envelope, A7

Envelope, DL, C5, C4

Labels™ A4, Letter - 0 0 X 0 X

o
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Glossy™ A4, A3, A3Nobi GSM 128g/m? (ream
paper 110kg)
GSM 127g/m? (ream
paper 110kg)
GSM 157g/m? (ream
paper 136kg)

Transparency® | A4, Letter - 0 0 X 0 X

Index cards 76".2m"m><127mm 0 X X 0 X
(3"x5")

*1: Use the printer control panel to set the paper size of the tray used to [Custom], and set [X Dimension] and [Y Dimension] to
the values shown in the table below. Use the printer drivers to select the values from the table below.

. Device Setup Setting the printer
Paper Size = ) .
Paper width (mm) |Paper length (mm) | driver [Paper size]
13"x18" 330 457 13x18in
4-Ren Hagaki 200 296 4-Ren Hagaki
Kakugata #6 162 229 Kakugata #6
Younaga #3 120 235 Younaga #3

*2: Print speed is slower for postcards, envelopes, labels, glossy paper, and transparencies.

(1 Note)

® If setting paper in the tray horizontally ([ 7), print speed will be slower than if set vertically (F).

® Printing will be slower if the paper size set is A6 or A5 size, or has a smaller width than 216mm.
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Paper

[ icon describes placing the paper horizontally
as viewed from the front of the printer. (Paper is

(Portrait) Icons fed vertically.)

P(Landscape) and r

| icon describes placing the paper vertically as
viewed from the front of the printer. (Paper is fed
horizontally.)

o
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Paper Feed
Orientation

Multi-Purpose Tray

Paper of the following sizes can be set either
horizontally or vertically.

Paper Feed
Orientation

Multi-Purpose Tray ® The three types of A4, A5, B5, and Letter 16K,
and A4 wide



Printing from Trays

Printing from Trays

With the exception of some paper sizes, the printer automatically detects the size of paper set in trays
1 to 5*. Further, only the width of the paper size is automatically detected.

*: Trays 2 to 5 are optional.

® The printer does not automatically detect the following paper sizes.
- A3BNOBI, tabloid extra, ABWIDE, 13x18"
-A5, A6
-postcards, Japanese double postcards
-legall3.5, legall4
-custom
If the printer does not detect automatically, use the control panel to set the paper size. For details, see “Setting Paper Using
the Control Panel” (P.93).

® Set 13x18" as custom size.

Setting Paperin Trays 1to 5 Slide the paper guide (D) and paper
stopper (@) to align to the size of the
This section explains how to set paper in tray 1 paper that has been set.

or trays 2/3/4/5.

® In this section, setting paper in tray 1 is used as an
example. Set trays 2 to 5 using the same procedure.

o
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1 Pull out the tray 1 paper cassette (D).

Thoroughly sort the paper. Carefully
align the ends of the paper horizontally.
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Printing from Trays

Set the paper with the print surface
face-down.

(! Note)

® Do not exceed the "y/" symbol (@) on the paper
guide when setting the paper.

® Set so there is no gap between the paper and the
paper guide or paper stopper.

Use the paper guide to secure the
paper.

6 Return the paper cassette to the tray.

Printing from Trays

Open the file to be printed on the PC, and
select [Paper Size], [Paper Source], and [Media
Weight] to print via the paper driver.

This section explains how to print using "Tray 1"
or "Auto" from the following printer drivers.

® Windows PS printer driver
® Windows PCL printer driver (P.90)
® Windows XPS printer driver (P.92)

® Mac OS X printer driver (P.92)

Further, this explanation uses "WordPad" for
Windows as the application used. For Mac OS X,
the example uses "TextEdit".

Reference

® For how to install the printer drivers, see "Connecting the
PC” (P.55).

® For how to print from the multi-purpose tray, see “Printing
from the Multi-Purpose Tray” (P.93).

® Select [Auto] in [Paper Source] to automatically select the
tray holding the designated paper.
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m Using Windows PS Printer Drivers

Open the file to be printed using
WordPad.

Click [Page Setup] in the [File] menu.

Select the paper size and print
orientation, and click [OK].

Click [Print] in the [File] menu.

Click [Advanced] (or [Preferences]).

Grhh Lo —
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Printing from Trays

Use [Paper Source] in the [Paper/
Quality] tab to select the tray to be
used, and click [Advanced].

5 IntaPrint SP1360(PS) Printing Preferences X

Layout Paper/Qualty Job Options  Color

CyE=

Paper Source:

&7 Multi-Purpose Tray

Media: Printer Setting >

Color

(O Black & White @ Color

Advanced...

Conos | [ ooy

Select a suitable value from [Media
Weight] in the "Advanced Options"
screen, and then click [OK].

IntoPrint SP1360(PS) Advanced Options x

@ IntoPrint SP1360(PS) Advanced Document Settings
-4 Paper/Output

Paper Size: Letter

-] Graphic

L= @ Image Color Management

: : ICM Method: |CM Disabled

ICM Intent: Pictures
TrueType Font: Substitute with Device Font
2-f Document Options
Advanced Printing Features: Enabled

Pages per Sheet Layout: Right then Down
Booklet Binding Edge: On Left Edge
=0 PostScript Options
[=! % Printer Features
i Page Rotate: Mormal
Check paper in any other tray: On

CHIELA AR 1 LIE i

Media Weigh

Tray Switch: On

S

® Normally, select [Printer Setting]. Select [Printer
Setting] to use the values set using the printer
control panel.

e If outputting to the face-up stacker, open the printer

face-up stacker, and select [Stacker (Face-Up)] in
[Output Bin].

Click [OK] in the "Printing preferences"
screen.

Click [Print] in the "Print" screen to
print.

m Using Windows PCL Printer
Drivers

Open the file to be printed using
WordPad.

Click [Page Setup] in the [File] menu.

Select the paper size and print
orientation, and click [OK].

Click [Print] in the [File] menu.
Click [Preferences].

Select [Tray 1] in [Source] in the
[Setup] tab.

@ IntoPrint SP1360(PCL6) Printing Preferences X

SHOCIT-h LCON —

Setup

Lelier 8.5 11in ~

[ Resize document to it printer page

Mulipu

|| Paper Fesd Options

e |Standard ~ Options

[Norel -

AIntoPrint About Defat

Select a suitable value in [Weight], and
click [OK].

@ IntoPrint SP1360(PCL6) Printing Preferences X

Setup  Job Options  Extend

Driver Setting

T L) s Letier 85 11in <

[ Resize document to it printer page

A Finishing Mode | Standard - Oplions.

2-5ided Prining [iore) 5

Orientation ® Pottrait [mRkis
l i OlLandscape (180 A
olor

Current color mode : Automatic

‘ Saurce: Mukipurpose Tray 5
(Ms\ghl Piinter Setting v) Eseilieed Dpions

AIntoPrint About Defat

® Normally, select [Printer Setting]. Select [Printer
Setting] to use the values set using the printer
control panel.

8 Click [Print] in the "Print" screen to

print.



Printing from Trays
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Printing from Trays

B Using Mac OS X Printer Drivers

1
2

Open the file to be printed using
TextEdit.

Click [Page Setup] in the [File] menu.
Select the paper size and print

orientation using the page setup dialog
box, and click [OK].

Settings: | Page Attributes il

Format For: | OKI C931(PS) :)

—
( Paper Size: | A4 0 \)

0~

Scale: | 10

= Sance

Select [Print] in the [File] menu.

Select [Paper Feed] in the print dialog
box.

Check that [Auto Select] has been
selected.

Copies: () Two-Sided

Pages:
ges: @AH :
O From: [1 to: [1

Paper Size: [ A4 4] 210 by297 mm

I [1=)

[ Paper Fe —

(@ All Pages an' | Auto Select n '
() First Page Froy -

Orientation:

my

(e <] 1002 (> 1ob1) Remaining From: | Multi-Purpose Tray

() [ P ~) [ Hide Details | Cancel | [[Print)

Select [Print Options] using the print
dialog box.

Chick the [Feed] tab in the printer
setup panel, and select [Media Type]
and [Media Weight].

Printer: | OKI C93 1(PS) 3]
Presets: | Default Settings &l
—— g |
Copies: [1___| () Two-Sided |
|
Pages: @ Al
OFrom: [1 to: |1
Paper Size: [ A4 +) 2106y207mm
| Print Options 3 ——

{ Qualityl | Qualit

—— Media Type: | Printer Setting
<) lofl ()

Media Weight: | Printer Setting -
[ Tray Switch

 Multipurpose tray is handled
as manual feed |
|
(] Check paper in the multi-purpose tray |
() Check paper in any other tray |

Pocver, 100

|
(2) [POF +| [ Hide Details | Cancel | |
|

® Normally, select [Printer Setting]. Select [Printer
Setting] to use the values set using the printer
control panel.

9 Click [Print] to print.



Printing from the Multi-Purpose Tray

Printing from the Multi-Purpose Tray

Setting Paper in the Multi- Select [Media Type], and press the [OK]
Purpose Tray button.
MPTray Config 111 Page
nPaper Size
Setting Paper Using the Control B3 X Dimension
Pa nel B Y Dlensu)n
If the paper size is "Envelope" or "Custom Size", B Media Weight
use the control panel to set the paper size. @ Tray Usage
(L) Usa Onling button to return to standby screan.

1 Press the [Fn] key.

) ) ) Press the scroll buttons AW to select
The numerical values input screen will

the type of paper that has been set,

be displayed. and click the [OK] button.
2 Press [9], [0], and click the [OK] e
button.
Letterhead __'?
[ Har MENU  ONLINE ) Transparency '%
O () P2 2
ABC DEF Bond

(&) (5 (6)

GHI JKL _MNO

POWER SAVE w CM@. @
@ @@/ Press the [BACK] button to return to
ATTENTION Fn CLEAR

the previous screen.

Recycled
O Use Online button to retumn t...

MPTray Config 1/1 Page
Press the scroll buttons AW to select @ Paper Size
the size of the paper that has been set, 2 JRBhemt
and press the [OK] button. BYD'_”‘e"sm"
a Media Type
Paper Size Media Weight
n AdWide? ﬂTray Usage
a AdWide[] O Use Online button to return to standby screen.

E) BoHal
Select [Media Weight], and press the
[OK] button.

() Use Online button to returnt... MPTray Config 1/1 Page
n Paper Size
Press the [BACK] button to return to 2 s
H B Y Dimension
the previous screen. )
n Media Type
MPTray Config 1/1 Page B Media Weight
n Paper Size B Tray Usage
EX Dimension O Use Online button to return to standby screen.
B Y Dimension
ﬂ Media Type
Media Weight
E Tray Usage
() Use Online button to return to standby screen.
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Printing from the Multi-Purpose Tray

Press the scroll buttons AW¥ to select Setting Paper
the size of the paper that has been set, The multi-purpose tray prints to the face-up side
and press the [OK] button. of the paper that has been set.

edia Weight (! Note)
1 g
Ultra Light
Light
Medium Light
Medium
Medium Heavy
(L) Use Online button to returntt...

® Do not collate and set paper of different sizes, types, and
thicknesses at the same time.

® If setting custom size paper, it is necessary to register the
size. For details, see "Advanced".

Open the multi-purpose tray (1)
1 Press the [BACK] button several times towards you.
to return to the standby screen.

Ready To Print

100% 100% 100% 100%

o
i
S Yellow Magenta Cyan Black

® Press the [CANCEL] button to return to the standby

screen.

Pull the setting lever (@) on the right of
the paper supporter (1)) towards you.




Printing from the Multi-Purpose Tray

Adjust the paper guide (D) to the width Adjust the paper guide to fit the width
of the paper that has been set. of the paper that has been set.

Thoroughly sort the paper. Carefully Release and return the setting lever ()
align the ends of the paper horizontally. to its original position.

Place the print side face-up, and set the
paper.

(! Note)

® When adding paper, remove the paper in the multi-
purpose tray, and align the additional paper top, bottom,
left, and right before setting.

® Do not take out or add paper while printing.

® Do not place anything other than the paper to be printed
on the multi-purpose tray, apply pressure from above, or
apply unnecessary force.

® The paper supporter will automatically lift up when the
(! Note) paper is set in place. If the paper supporter gets in your
way of setting paper in the tray, place paper after opening
the toner replacement cover, and then close the cover
when it is set in place.

Bunund




Printing from the Multi-Purpose Tray

Printing from the Multi- m Using Windows PS Printer Drivers
Purpose Tray Open the file to be printed using
WordPad.

Print to the paper set in the multi-purpose tray.
The main operating procedures are described

below. Click [Page Setup] in the [File] menu.

Select the paper size and print

Set the paper (@) in the multi-purpose
orientation, and click [OK].

tray (D).
Click [Print] in the [File] menu.

Click [Preferences].

Click [Advanced] in the [Layout] tab.

SHOCIT-h LCON —

s@u IntaPrint SP1360(PS) Printing Preferences x
Layout | Paper/Quality Job Options ~ Color
Orientation:
EREZNN
3 Print on Both Sides:
g-. | [@ Nene V|
8 Page Order: ==
[ Front to 8ack ] —
. . Page Format _—
2 Open the file to be printed. © page e st —
() Booklet
Specify the [Multi-Purpose Tray] using Jerte
the printer drivers to print.
This section explains how to print using the e
multi-purpose tray from the printer drivers.
® Windows PS printer driver Concel | | o

® Windows PCL printer driver (P.98)
® Windows XPS printer driver (P.99)

® Mac OS X printer driver (P.99)

Further, this explanation uses "WordPad" for
Windows as the application used. For Mac OS X,
the example uses "TextEdit".

Reference

® For how to install the printer drivers, see “"Connecting the
PC” (P.55).



Printing from the Multi-Purpose Tray

Select [Paper Size] from [Paper/Output]
in the "Advanced Options" tab.

IntePrint SP1360(PS) Advanced Options

@= IntoPrint SP1360(PS) Advanced Document Settinas
=42 [ fpEr Ottput

-l O
E-@ Image Celor Management
v ICM Method: ICM Disabled
ICM Intent: Pictures
£ e TrueType Font: Substitute with Device Font
E@ Document Options

e Advanced Printing Features: Enabled
Pages per Sheet Layout: Right then Down
Booklet Binding Edge: On Left Edge
(-0 PostScript Options
E-% Printer Features
[ Page Rotate: Normal
Check paper in any other tray: On
Check paper in the multi-purpose tray: Off
Media Weight: Printer Setting
Multipurpose tray is handled as manual feed: No
Tray Switch: On

[Letter

Cancel

Select [Multi-Purpose Tray] in [Paper
Source] in the [Paper/Quality] tab, and
click [Advanced].

E@ IntaPrint SP1360(PS) Printing Preferences *
Layout Paper/Quality Job Options  Color
T —
Paper Source:
Media: | Printer Setting ~
Color
O Black & White @ Color
Advanced...
Cancel Aeply

Select a suitable value from [Media
Weight] in the "Advanced Options"
screen, and then click [OK].

IntoPrint SP1360(PS) Advanced Options

@5 IntoPrint SP1360(PS) Advanced Document Settings
E1-42 | Paper/Output

i Paper Size: Letter
£ lu] Graphic

2-{) Image Color Management

: ICM Method: [CM Disabled

ICM Intent: Pictures
TrueType Font: Substitute with Device Font

-} Document Options

. Advanced Printing Features: Enabled

- Pages per Sheet Layout: Right then Down

- Booklet Binding Edge: On Left Edge
#% PostScript Options
-, Printer Features

<. Page Rotate: Normal

- Check paper in any other tray: On
- M edia Weight:

e Tray Switch: On

Medium

Cancel

® Normally, select [Auto]. Select [Auto] to use the
value set using the printer control panel.
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® To print pages individually, set [Multipurpose tray is
handled as manual feed] to [Yes].

Click [OK] in the "Printing Preferences"
screen.

1
1

Click [Print] in the "Print" screen to
print.
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Printing from the Multi-Purpose Tray

m Using Windows PCL Printer Drivers

ST CON =

/

Open the file to be printed using
WordPad.

Click [Page Setup] in the [File] menu.

Select the paper size and print
orientation, and click [OK].

Click [Print] in the [File] menu.
Click [Preferences].

Select [Size] in the [Setup] tab.

5 IntoPrint SP1360(PCL6) Printing Preferences X

Setup  Job Options  Extend

Diiver Seting
Curent setting ] (5‘ZE ’LEHNEWM—VD
Save Management e
Souee: Multpurposs Tray <
Type: Printer setfing ~
Weight PrinterSeting | | PaperFeed Options

FinishingMode | Standard ~ Options.

RJac

25idedPritg  [(rione)

Orientation @ Portrait O
O Landscaps (1807 A

ColorSeting @ Color Current color mode : Automatic
O Manochiome Detail

Toner saving off >
[ Do not save 100% black toner

AintoPrint About Defauit
Cancel Aosly Help

Select [Multipurpose Tray] in [Source].

5 IntoPrint SP1360(PCLE) Printing Preferences X
Setup  Job Options  Extend
Diiver Selting
Size: Lelter 851 1in v
Curent selting v
[ Resize document to ft pinter page:
Save. Management.
Seunce: Mullipurposs Trap v)
T n e g
Weight: Piinter Setting hd Paper Feed Options.
A FringHots [Standard Y e
25idedPritg  [(rione) MIag]
Oriertation @ Parhait a0
l i OlLandscape (11807 A
ColorSeting @ Color Curtent color mode : Automatic
O Monachrome Detai.
Toner saving aff ~
[ Do not save 100% black toner
AintoPrint About Dt
Cancel Aoply Help

8

1

Click [Paper Feed Options].

5 IntoPrint SP1360(PCLE) Printing Preferences. X
Setup  Job Options  Extend
Driver Seting
Size: Letter 85x 11in v
Curient setting hd
[ Resizs document to it printer page
Save. Management.
Source: Mulipurpose Tray v
Type: Printer setting
weight Piker Seting Papei Feed Options
A Finiching Mode | Standard - Options
25ided Piinina [yng) o
Orientation @ Portrait [mREls
l i Olandscape (1190 A
Color Seting @ Color Curent color mode : Automatic
(O Manochiome Detail
Toner saving off -
[JDe net save 100% black toner
AIntoPrint About Defaukt
Cancel Aeply Help

® To print pages individually, enable [Use MP tray as
manual feed] in [Multi Purpose Tray Settings], and
click [OK].

Paper feed options X
Cover Printing Paper feed options
[ Use different source for first page Auta Tray Change
Media Check
[ Multi Purpose Tray
Other Traps

FILI CLIPUSE gy 3EWngs
Usze MP tray as manual feec

ey

Custom Size... Default

Cancel Help

Select a suitable value in [Weight], and
click [OK].

4 IntoPrint SP1360(PCLE) Printing Preferences b3

Setup  Job Options  Extend

Driver Setting
Size: Letier 8.5 11in <

Curient sefiing
[ Resize document to it printer page

Save Management

Source: Mulipurpose Tray g

Pinter Setiina V) Paper Feed Opiions

Standard ~

Finishing Mode Options

2ided Pining [ iore) o

Orientation ® Portrait [mREls
Olandscape  [180° A

Color Settng @ Color Current color mods : Automaic
(O Monachrome Detail.

Tonersaving  |0fF v

[JDa ot save 100% black toner

dintoPrint Aot

Defauit

=
/Memo

® Normally, select [Printer Setting]. Select [Printer
Setting] to use the values set using the printer
control panel.

Click [Print] in the "Print" screen to
print.



Printing from the Multi-Purpose Tray

B Using Mac OS X Printer Drivers

1
2
3

(S, L -\

Open the file to be printed using
TextEdit.

Click [Page Setup] in the [File] menu.

Select the paper size and print
orientation using the page setup dialog
box, and click [OK].

Settings: | Page Attributes gl

Format For: | OKI C931(PS) dal

( Paper Size: (A4 3] )
Orientation: m |§| I

Scale: |100 %

> ()

Select [Print] in the [File] menu.

Select [Paper Feed] in the print dialog
box.

Printer: [ OKICO31PS)  ¢]
Presets: | Default Settings 1)
Coples: (] Two-Sided
Pages: (&) All -
& | tor [1
PaperSize: (A4 i) 210by297mm

Orientation: |

(OFirst Page From: | Multi-Purpose Tray

(W <) 1of1 [ %) Remaining From: | Multi-Purpose Tray

(e | ()

(2) (PDF 7| [ Hide Details |

Select [Multi-Purpose Tray] in [All Pages
From].

Printer: [OKICO31PS) 3|

Presets: | Default Settings 4

to: [1

¢ 210 by297 mm

Paper 5

| Paper Feed. O
(®) All Pages Fmr' | Multi-Purpose Tray ) '
() First Page From S —

om: | Multi-Purpose Tray

O <] 101 (> o%i)

(2) [ POF +| [ Hide Details Cancel |

® Normally, select [Auto]. Select [Auto] to use the
value set using the printer control panel.

Select [Print Options] using the print
dialog box.

Printer: [OKICO31PS) 3|

Presets: | Default Settings |

Quality: | ProQ/High Quality
Uetio] ez [ibii] (7] Optimize color thin line
[ image Smoothing
Trapping: | OFF
™ Adjust ultra fine lines.

() Black Overprint

¥/ Always use printer halftone

[Cancel |

(2) [PDF v] [ Hide Details |

Chick the [Feed] tab in the printer
setup panel, and select [Media Type]
and [Media Weight].

Printer: [OKICO3ICPS) ¢

Copies: [ Two-Sided

Pages: (&) All
(OFrom: |1 to: |1
Paper Size: | A4 4] 210by207 mm

(6T9) 101 (> Tob)

Media Weight: | Printer Setting 4]

[ Tray Switch

o Multipurpose tray is handled
as mat ed

[ Check paper in the multi-purpose tray

(" Check paper in any other tray

POE Ver. 100

(2) [POF ~] [ Hide Details |

(canet |

9 Click [Print] to print.
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Outputting Paper

Outputting Paper |

The printer outputs the paper either to the face-dowin stacker or the face-up stacker.
heets of GMS 64g/m? paper.
ets of GMS 64g/m’ paper.

The face-down stacker can accumulate approx. 62
The face-up stacker can accumulate approx. 300 s

m Using Windows PCL Printer Drivers
1 Open the file to be printed.

Using the Face-Down

Stacker (Print Face Is Down)

The paper is output with the print side face-
down. Papers are stacked in the order in which

2 Click [Preferences] in the "Print" screen.
they are printed.

Select [Stacker (Face Down)] in [Output
Bin] in the [Job Options] tab, and click
[OK].

5 IntoPrint SP1360(PCLG) Printing Preferences x

To output from the face-down stacker, specify
the face-down stacker in "Output Bin" using the
printer drivers.

Sewp  dob Options  Exend

Driver Setting

m Using Windows PS Printer Drivers

T o] Qualy @ Prol /High Quaity []Pheto Enhanes
(O Fine / Dietail (120041 200) ] 0ptimize color thin fine:
S, M. t
) O h ﬁ I b : d o ersgemen O Nomal (6001500)
= pen the file to be printed. = H oo
3
5- Copies: 1 + [coliste
Qa Rotate Sort
A Job Type @ Nomal (O Encrppted Secure Print

2 Click [Preferences] in the "Print" screen.

Setting

i b Do
lli (Dmuut Bin Stacker (Face Down) v )

3 Select [Stacker (Face-down)] in [Output

Bin] in the [Job Options] tab, and click

[OK] AIntoPrint Advanced Defat
Cancel Aoply Help

= IntaPrint SP1360(PS) Printing Preferences b4

Layout Paper/Quality Job Options  Color

4 Implement printing.

4 Implement printing.

~Job Typ
& Normal
€ Secure Print ﬂl
" Store for Re-print
£~ Encrypted Secure Print
Copies: E

@ Profl/High Quality ™ Collate

" Fine / Dietail (1200:1200] ™ Raotate Sort

ol Hoimal (B00<600) Scae [100 =1 (1000%)

™ Optimize color thin line

[~ Image Smoothing ~ Fit to Page

Trapping ™ Resize document ta fit printer page

OFF - Letter

o c Letter vI

Output Bin;

Stacker [Face-down] vl

Adjustment... | watermarks. .. | Owerlays... | Advanced. I

=
JIntoPrint fbout.. | Defaukt |
Cancel Aeply
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Outputting Paper

m Using Mac OS X Printer Drivers Using the Face-Up Stacker
Jwem (Print Face Is Up)

® This section uses "TextEdit" as an example.

The paper is output with the print side face-

Select [Stacker (Face-down)] in [Output
Bin] in the [Paper] tab.

1 Open the file to be printed. up. Paper is stacked in the reverse order from
printing.
Select [Print] in the [File] menu. To output from the face-up stacker, specify the
face-up stacker in "Output Bin" using the printer
3 Select [Print Options] using the print drivers.
dialog box. 1 Open the face-up stacker () on the
4 left of the printer.

Printer: [ OKI C931(PS)

Presets: | Default Settings

Copies: (2| () Two-Sided

| Print Options. H—m—
{ Qualityl | Quality2 | Feed TN
 Collate

Rotate Sort

o
=
3
(=4
3
«Q

[ Page Rotate

(Ompur Bin: | Stacker (Face-down) :)

2 Open the paper supporter (@) as
shown in the diagram.

(2) [POF +] [ Hide Details | [ Cancel |

Click [Print] to print.

The printed paper will be output to the
face-down stacker (output tray) (D).

S On

3 Rotate the auxiliary supporter (®) in
the direction of the arrow until its lock
position.
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Outputting Paper

4 Open the file to be printed. m Using Mac OS X Printer Drivers

Customers using Mac OSX go to “Using
Mac OS X Printer Drivers” Step 5. ® This section uses "TextEdit" as an example.

5 Click [Advanced] in the "Print" screen. Select [Print] in the [File] menu.

m Using Windows PS Printer Drivers _
dialog box.

Select [Stacker (Face-up)] in [Output
Bin] in [Job Options], and click [OK].

) IntoPrint SP1360(PS) Printing Preferences X

Select [Stacker (Face-up)] in [Output

6 Select [Print Options] using the print
7 Bin] in the [Paper] tab.

ity Job Options =
Layout Paper/Quality Pt Color Printer: [ OKIC931(PS) 3]

b T 2
& Normal
€ Secure Print Setting.

DStaz st Paper Size: | Envelope Kaku3  #| 216 by277 mm

£~ Encrypted Secure Print Orientation: @
Copies: E

| Print Options A——

@ Profl/High Quality ™ Collate ' m

" Fine / Dietail (120041200) [T Rotate Sort el

N | [B00:E00] = 2, (=T < 1of1 (= 10w

m_mé[ i .] ) Scale: [100 11000 %) Rotate Sort

™ Optimize color thin line
o o =
a1 [~ Image Smoothing ~FittoPage——————————————— (] Page Rotate
g-_ Trapping I~ Resize document to fit printer page (o,m,,,, T T — )
= aFF - Letter

c ILelter ;I
P0E ver. 100
— T —cs. . | Owerlays... | Advanced. I
w S I
jlntnprlnt About... | Default I (2) [PDF | [ Hide Details | | Cancel |

Cancel Hoply

Click [Print] to print.

7 Implement printing. Printed paper is output to the face-up
stacker (D).
m Using Windows PCL Printer Drivers

Select [Stacker (Face Up)] in [Output
Bin] in [Job Options], and click [OK].

#h IntoPrint SP1360(PCLE) Printing Preferences X

Setwp | Job Options  Extend

Difver Setting
o] Quaity ® Pral) / High Qualiy [ Phate Enhance

Curent setting
(O Fine / Detai [120041200) [ ptiize color thin fne

© Normal (6003500
Scale 100 |3 [JDisable
Copies T2 Ocolse

Fiotate Son
A Job Type i O Eneiypted Secure Piint

ll i (Dulpm Bin Stacker [Face Lp) )

Setling.

AIntoPrint Advanced. Detaul

7 Implement printing.
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Setting Power Save Mode

4. Basic Device Operations

This chapter explains how to set power save mode, which reduces device power consumption, how
to check print quantities, the service life of consumables, remaining maintenance unit quantities and
service life, and how to cancel printing.

You can set the printer to enter power save mode from the standby screen. Further, you can also set
the printer to enter sleep mode from power save mode.

Setting Power Save Mode

Setting Power Save Mode 3 Enter the adminlstrator password, and

The device can be set to enter power save mode

from standby mode when no printing or data has
been received after a fixed period of time. ® In the default factory settings, the administrator
. . password is [The first 10 digits of the serial
The default factory setting is to enable power number].
save, so implementing this procedure is =
unnecessary.
{6 - 12 digits )
1 Press the scroll button A or v,
(" HELP " onL 4
ENU N LINE
2022 >
BAck . @ U . OUse Online button to return to standby screen.

mu OK GHI  JKL  MNO
Po O cnen (7)) (®)(9) 4 Select [Power Setup], and press the
WER SAV w O PQRS TUV WXYZ [OK] button
L -
ATTENTION CLEAR
Admin Setup 2/2 Pagﬂ

nPaneI Setup
Select [Admin Setup], and press the B Time Setup

[OK] button.

n Others Setup

o]
@
o
3)
o
@
=
o
[
o

=
@
3
)
=3
o
=1
*

Functions 1/2 Page B Settings
n Configuration a Change Password
g Print Information O Use Online button to return to standby screen...
a Print Secure Job
B Menus 5 Select [Power Save], and press the [OK]
button.
a E] Print Statistics
O Use Online button to return to standby screen... Power Setup 1/1 Page
n Power Save
Sleep

B Auto Power Off

O Use Online button to return to standby screen.
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Setting Power Save Mode

Select [Enable], and press the [OK] Setting the time before the
button. printer enters power save mode

You can set the time until power save mode is
entered.

Disable
The default factory setting is "1 min."

Lengthening the time until power save mode
is entered may shorten the time until printing

Use Online button to returnto s... starts.
Press the [ON LINE] button to return to 1 Press the [Fn] key.
the standby screen. The numerical values input screen will
(" Hewp ven (T h be displayed.
O () DB 2 Enter [2], [0], [0], and press the [OK]
) @ % button.
W (7)(8)(9) / )
POWER Save PQRS  TUV  WXYZ HeLe MENU  ONLINE
T ,208¢ Pt
TTENTION LEAR, ikt
Ready To Print C @
ea o Prin - ANCEL
POWER SAVE O g 9 g
O e RO
ATTENTION CLEAR

)
D [I I] I Select the time to be set, and press the
[OK] button.

Yellow Magenta Cyan Black

Power Save Time

® Other items can also continue to be set before n‘” mnme
pressing the [ON LINE] button. 2 minutes

@
fs1}
08
(o]
o
@
=,
(o]
®
o
o
[
S
=4
o
3
wn

3 minutes

4 minutes

5 minutes

10 minutes
() Use Online button to retum t...
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Setting Power Save Mode

Press the [ON LINE] button to return to Setting Sleep mode

the standby screen.

(" HEeLp

Yellow

Magenta

ON LINE

O

CANCEL

O

1€
(@) (5) (6

GHI

(7)(8)(9)

ABC

JKL

DEF

MNO

PQRS TUV WXYZ

PO,

Cyan

® The settable times are described below.

1 min., 2 mins., 3 mins., 4 mins., 5 mins., 10 mins.,

15 mins., 30 mins., 60 mins.

The device can be set to enter sleep mode from
power save mode when no printing or data has
been received after a fixed period of time.

The default factory setting is to enable sleep, so
implementing this procedure is unnecessary.

1 Press the scroll button A or w.

(" HELP

S oo

BACK e
(6D o=

PQRS TUV WXYZ

POWER Sav v
(05

2 Select [Admin Setup], and press the
[OK] button.

Functions 1/2 Page
n Configuration

B Print Information

B Print Secure Job

ﬂ Menus

B E| Print Statistics

O Use Online button to return to standby screen...

'S

o]
@
@,
(a]
o
@
=
o
[
o

=
@
3
)
[=4
o
=1
w

3 Enter the administrator password, and
press the [OK] button.

® In the default factory settings, the administrator
password is [The first 10 digits of the serial
number].

Enter Password

******
{6 - 12 digits }

O Use Online button to return to standby screen.

Select [Power Setup], and press the
[OK] button.

Admin Setup 2/2 Pagﬂ
n Panel Setup
a Time Setup

B Power Setup

n Others Setup
a Settings
E Change Password

O Use Online button to return to standby screen...
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Setting Power Save Mode

h Select [Sleep], and press the [OK] Setting the time before the
button. printer enters sleep mode

Power Setup 141 Page
@ Power Save You can set the time until sleep mode is entered.

The default factory setting is "15 mins."

B Auto Power Off

Lengthening the time until sleep mode is entered
may shorten the time until printing starts.

O Use Online button to return to standby screen. Press the [Fn] key

The numerical values input screen will

6 Select [Enable], and press the [OK] be displayed

button.
Enter [2], [0], [1], and press the [OK]

button.
(" HELP " onL
ENU N LINE
@ O -Q
) G
o 5 5
POWER SAVE O PQRS _THV_ WXYZ
Press the [ON LINE] button to return to \@ . @%
the standby screen. T
. [ e ) Select the time to be set, and th
g Menu  (ONLINE elect the time to be set, and press the
O ZNOPee [OK] button.
5- @ 1 Slaap Time
g ) e () (8 o @ v s i
%’J' O PQRS TUV WXYZ '. 30 minutes
@w @ . gj B 60 minutes

Ready To Print

() Use Online button to retum t...

Yellow Magenta Cyan Black

® Other items can also continue to be set before
pressing the [ON LINE] button.
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Setting Power Save Mode

Press the [ON LINE] button to return to
the standby screen.

(" HEeLp h

@ MEeNu O&Ljus @

(@) (5) (6

c GHI JKL MNO

ANCEL

C) &

O @
ATTENTION Fn CLEAR

Ready To Print

100% 100% 100% 100%

|

Yellow Magenta Cyan

® The settable times until sleep mode is entered are
described below.
1 min., 2 mins., 3 mins., 4 mins., 5 mins., 10 mins.,
15 mins., 30 mins., 60 mins.
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Setting Power Save Mode

Restrictions in sleep mode

This section explains the restrictions when the device is in sleep mode.

When the device is displaying an error, entering sleep mode may be disabled.

Printer driver utility restrictions

When the device enters sleep mode, the printer driver and utility functions are restricted as described

below.
(015 Software name Restrictions in sleep mode
Windows Configuration Tool Network settings for the Network Setting plug-in are disabled.
Network Extension Cannot connect to device.
Driver installer When connected to a network, the device options information cannot be
acquired while installing the printer drivers.
Mac OS X NIC Setup Tool Printer searches and settings are disabled.
Printer drivers Printing is disabled when connected using EtherTalk. Connect to the
device using either Bonjour (Rendezvous) protocols or LPD protocols
(TCP/1P).
For advanced setup methods, see either “"Using Bonjour (Rendezvous)”
(P.72) or “Adding Printers Using LPD (TCP/IP) Protocols” (P.117).

When the device enters sleep mode, press the [POWER SAVE] button on the control panel to check that
"Printing enabled" is displayed on the liquid crystal panel.

When "Printing enabled" is displayed, the restrictions described above do not apply.

w
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Setting Power Save Mode

Network function restrictions

In sleep mode, the following restrictions apply to
the network functions.

m Sleep mode is disabled
In the following cases, the device cannot enter
sleep mode.

® IPSec is enabled.

® A TCP connection has been established.
Example: A connection has been established
using Telnet or FTP, etc.

After the period for entry to power save mode
has elapsed in energy save mode, the printer will
enter sleep mode when the connection is cut.

® E-mail receiving is enabled.

® To enable sleep mode, disable IPSec/E-mail.

m Unable to print
While in sleep mode, printing using the following
protocols is disabled.

® NBT
EtherTalk*

°
® WSD Print
'3

: For Mac OS X, printing while in sleep mode is possible if
connected using Bonjour (Rendezvous) protocols or "LPD
protocols (TCP/IP)".

For setup methods, see either “Using Bonjour
(Rendezvous)” (P.72) or “Adding Printers Using LPD
(TCP/IP) Protocols” (P.117).

E Unable to search/setup

While in sleep mode, searches and settings
using the following functions and protocols are
disabled.

® PnP-X

® UPnP

® LLTD

e MIB*

*: Referencing using the parts of MIB (Get command) that
are supported is possible is sleep mode.

m Protocols with client functions do

not operate
While in sleep mode, the following protocols with
client functions do not operate.

® E-mail alert ™
® SNMP Trap

® WINS

*1: The elapsed time while in sleep mode does not include
the intervals between periodic communications times for
e-mail alerts.

*2: The elapsed time while in sleep mode does not include
the intervals between WINS refresh times.
WINS is not periodically refreshed while in sleep mode,
so the names registered to the WINS server may be
deleted.

B Moving automatically from sleep

mode to power save mode
In network environments with flows of large
packet quantities, the device may move
automatically from sleep mode to power save
mode and respond.

Subsequently, if the period for moving to
sleep mode elapses, sleep mode is entered
automatically.
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Setup to Turn OFF the Power Supply Automatically

Setup to Turn OFF the Power Supply Automatically

Setting auto power OFF 3 Enter the administrator password, and

® In the default factory settings, the administrator

mode

The device can be set to enter OFF mode

auto‘matically whgn no pr.inting or data has been password is [The first 10 digits of the serial
received after a fixed period of time. number].

In the default factory settings, auto power OFF Enter Password

mode is set automatically. Set according to the

conditions for entering OFF mode. {6 - 12 digits )

"Enable": Enters OFF mode automatically

"Auto Config": Enters OFF mode when the set time has
elapsed. If using a network connection,
however, OFF mode is not entered even
when the set time has elapsed.

O Use Online button to return to standby screen.

"Disable": The power Isl,upply does not turn OFF 4 Select [Power Setup], and press the
t ti .
automatically [OK] button.
1 Press the scroll button 4 or v, Adrin Setup 212 Page|
nPaneI Setup

(" HEeLp h
B Time Setup

Meny | Onlie
O m 0) SDLEILEY 3]

ABC DEF
n Others Setup

e (&) )
KOK%‘ GHI JKL MNO B settings
o @ B Change Password

POWER Sav w Q PQRS TUV WXYZ O Use Online button to return to standby screen...
@ F®
A n LEAR
TTENTION 5 Select [Auto Power Off], and press the

[OK] button.
Select [Admin Setup], and press the
[OK] button. Power Setup 1/1 Page
nPowerSave

Functions 1/2 Page g Sleep
g Print Information
B Print Secure Job

N

@
fs1}
08
(o]
o
@
=,
(o]
®
o
o
[
S
=4
o
3
1%

a Menus

o Use Online button to return to standby screen.

ﬂ E' Print Statistics

(1) Use Online button to return to standby screen... 6 Select [Enab|e] or [Auto Conﬁg], and
press the [OK] button.

O Use Online button to return to s..|
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Setup to Turn OFF the Power Supply Automatically

Press the [ON LINE] button to return to Setting the time before the printer
the standby screen. . enters Auto Power Off mode

(" HEeLp

@ Meny O&L')"E @ You can set the time until OFF mode is entered.
@ The default factory setting is "4 hours".
C&')CEL @.. 1 Press the [Fn] key.
QRS TUV  WXYZ
@ ®.gj The numerical values input screen will
e be displayed.
Ready To Print
’ 2 Enter [2], [0], [2], and press the [OK]
button.
(" HELP

OO @3

BACK
= &) (5) .
Yellow Magenta Cyan GHI ]KL MNO
_ CANCEL
POWER SAVE w

O PQRS "'"" WXYZ
® Other items can also continue to be set before @ C:)
pressing the [ON LINE] button. ATTENTION CLEAR

3 Select the time to be set, and press the
[OK] button.

Auto Power Off Time 1/2 Page

1 hour

i 2 hours

3 hours

'S
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8 hours
12 hours
(L) Use Online button to return t...

4 Press the [ON LINE] button to return to
the standby screen.

(" HEeLP h
@ MEeNU O&gz

GHI JKL  MNO

e ((B(9)
POWER SAVE

H Q PQRS TUV WXYZ

@ POY
ATTENTION CLEAR
/S

Ready To Print

® The settable times are described below.
1 hour, 2 hours, 3 hours, 4 hours, 8 hours, 12 hours,
18 hours, 24 hours
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Checking print quantities

Checking print quantities

You can check the quantity of printed paper to date.

You can also check the quantities printed (fed) from each tray.

1 Press the scroll button A or V. 5 Press the [OK] button.

(" Hew h MPTray

@ %\:u\ (85 ABC DEF
BAck - ®..
O e & 5 =

POWER SAv PQRS TUV wxvz
SLJO & =
\Lﬁm Cty

b0 Use Online button to return to s...

To continue checking other items, press

2 Select [Configuration], and press the the [BACK] button and return to 4.
[OK] button.
Functions 1/2 Page Press the [ON LINE] button to return to

the standby screen,
g Print Information

4 R\
B Print Secure Job HELP

MENU  [ONLINE
Qe O ANBleee
Admin Setup
4 B EPrint Statistics .

GHI JKL  MNO

CANCEL @ 0 @

O PQRS TUV WXYZ

O Use Online button to return to standby screen...

Select [Tray Count], and press the [OK]
button.

CLEAR

Ready To Print

@
fs1}
0}
(o]
o
@
=,
(o]
®
o

o
o
S
=4
o
3
1%

Configuration 1/1 Page

B Supplies Life
100% 100% 100% 100%

B Paper Size in Tray
a o D I] I]

(L) Use Online button to return to standby scraen. flelios Magenta Evan

()

lect the tray to be checked.

‘4 S

Tray Count 111 Page

g Trayl
B Tray2
a Tray3
Trayd
B Trayb

O Use Online button to return to standby screen.
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Checking Consumables, and Remaining Maintenance Unit Quantities and Service Life

Checking Consumables, and Remaining
Maintenance Unit Quantities and Service Life

You can check the remaining quantities and service life of the toner, image drum, belt unit, fixer unit,

and waste toner box.

1 Press the scroll button A or v,

(" HELP

ST oFT]
“ (57 (6)

KOK/H‘ CANCEL GHI IKL e
€]
ORey
ATTENTION CLEAR

Select [Configuration], and press the
[OK] button.

Functions 1/2 Page
n Configuration

Print Infermation

B Print Secure Job

ﬂ Menus

B EAdmin Setup

B E]Print Statistics

O Use Online button to return to standby screen...

Select [Supplies Life], and press the
[OK] button.

Configuration 1/1 Page
n Tray Count

g Supplies Life

B Paper Size in Tray

a System

(_) Use Online button to return to standky screen.

Select the consumable or maintenance
unit (image drum, belt unit, fixer unit,
or waste toner box) to be checked.

Supplies Life 1/2 Page
Magenta Toner (10.0K}

B Yellow Toner (10.0K)

(3 Black Toner (10.0K)

a Cyan Drum

B Magenta Drum

(0) Use Online button to return to standby screen...

5 Press the [OK] button.

van Toner {10.0K}
Remaining 100 %

() Use Online button to return to s...

To continue checking other items, press
the [BACK] button and return to 5.

6 Press the [ON LINE] button to return to
the standby screen.

(" HELP h

@ MENU (6:@)@@

(a) (5 (6)

GHI ]KL MNO

CANCEL

O PQRS TUV WXYZ

Yellow

® The value to the right of the toner in the remaining
consumables quantity screen changes depending on
the type of toner cartridge installed.
"10.0K" is displayed at the time of product purchase
and when a standard toner cartridge is mounted.
"24.0K" is displayed when a large-capacity toner
cartridge is mounted.

Magenta Cyan
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Canceling Printing

Canceling Printing

To cancel data while printing or during print
preparation, press the [CANCEL] button on the
control panel.

(" HEeLP h

@ MEeNU O&Ljus @@@
@ (e

GHI JKL  MNO

Shee
9
Fn

CLEAR

When the [CANCEL] button is pressed, the
following screens will be displayed.

Print Configurati Cancel Data?

To cancel printing, select [Yes], and press the
[OK] button.

To continue printing, select [No], and press the
[OK] button.

If no operation is implemented within 3 mins.
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will disappear and printing will continue.

while this screen is displayed, the screen display
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Adding Printers Using LPD (TCP/IP) Protocols

Adding Printers Using LPD (TCP/IP) Protocols

With Mac OS X environments, you can connect printers using LPD protocols (TCP/IP).

Apple Talk cannot be used with Mac OS X 10.6 or later, so for network connections, connect the printer

using Bonjour (Rendezvous) protocols or LPD protocols (TCP/IP).

Printers

1

Check that the IP address, subnet
mask, and router address, etc., have
been set correctly for the desired Mac
0S, and that you are connected to the
network using LPD protocols (TCP/IP).

Download the PPD installer for Mac

OS X for the printer to be connected
from the homepage (https://www.
IntoPrint.com/support), unzip and start
the PPF installer, and then install PPD
on the relevant Mac OS. This step is
unnecessary if PPD is already installed.

Set the IP address, subnet mask, and
gateway address, etc., on the printer to
be connected. Make sure the printer is
turned ON, and connected to the TCP/
IP network environment.

1

-117 -

Open the Mac OS system environment
settings, and click the "Print & Scan"
icon to open the "Print & Scan" screen.

- NaXs] System Preferences
2l
Personal
- ; o €]
B a - & o @
General  Desktop & Dack Mission Language  Security Spotlight  Notifications
Screen Saver Control &Tent & Privacy
Hardware

CDsaDVDs  Displays Energy Keyboard Mouse Trackpad [ Print & Scan Sound
Saver

Internet & Wireless

iCloud  Mail, Contacts  Network Bluetooth Sharing
& Calendars

System

K » @G @® & @ = |
Users & Parental Date & Time Software Dicration Time Machine Accessibility Startup Disk
Groups Controls Update & Speech

Click the [+] button to open the "Add
printer" screen.

8 0o Print & Scan

[ —

No printers are available.
Click Add (+) to set up a printer.

Default printer: | Last Printer Used 3]

Default paper size: \".'G“ e -:"\

p @
Click the lock to prevent further changes. \&)
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Adding Printers Using LPD (TCP/IP) Protocols

3

Select the [IP] icon. The following screen
will be displayed. Enter the printer IP
address, "Queue" name, and "Name",
and then check that the printer to be
used is selected in "Use", and click the
[Add] button.

e0e Add
 leyla -
Default  Fa» P ‘ndows Search
Mdu'-: 192.168.0.3 ) (1)
BN e rintes Dacsuom . LED n
Q I 2
+{(C— ) (@
Nan([CQSl(PS) I) (3)
Location:
u( OKI C931(PS) :|) (4)
'\' Add |'
4

(1) Enter the IP address allocated
to the printer in the client
environment.

(2) Enter "Ip" as the queue name.

(3) The IP address entered in Step (1)
will be displayed. Enter any desired
name.

This explanation uses SP1360 (LPD)
as an example.

(4) The printer to be used (PS) will
be displayed automatically as the
driver.

If you cannot communicate
properly with the printer, auto
selection will not be implemented.

C! Note)

® When the printer is in sleep mode, the drivers may
not be selected correctly. Return the printer from
sleep mode, and then enter the printer IP address
in [Address].

4 Set the printer options, and click [OK].

| |
ﬁ Setting up ‘C931(PS)..." |

Make sure your printer’s options are accurately shown here
so you can take full advantage of them.

Available Trays: [ 1 gl

Hard Disk

\M'l@'
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The "Print & Scan" screen will be
displayed, and the printer to be used
(LPD) will be added to the printer list.
Select the printer to be used (LPD) as
the "Default printer".

800 Print & Scan

<> Show All (Q
= €931(LPD)
=] ﬁ
A L8 Default
s | Open Print Queue. |
| Options & Supplies... |
Kind: OKI C931(PS)
Status: idle
("] Share this printer on the network | Sharing Preferences...
==
Default prmte( €931(LPD) : )
Default paper size: | me
n (?)
| Click the lock to prevent further changes. L)

This way, the desired printer will be
used as the default when printing. This
completes the procedure for adding

a printer, so close the "Print & Scan"
screen.
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Appendix

© Table of control panel menu items

Numbers following the letter F in the menu items indicate the function number.

|Configuration |

—Tray Count F{MPTray
—Trayl

—Tray2 ™t
HTray3 ™t
HTray4 "t
—Tray5 ™t

— Supplies Life —{Cyan Toner (n.nK)
—Magenta Toner (n.nK)
—Yellow Toner (n.nK)
—Black Toner (n.nK)

— White Toner (n.nK) "2 *4*6
— Clear Toner (n.nK) 37
—Cyan Drum

—Magenta Drum

— Yellow Drum

—Black Drum

—White Drum 27476

— Clear Drum "3™4*7

— Waste Toner Box

— Belt

—Fuser

— Network }-—{Printer Name

—Short Printer Name
—IPv4 Address
—Subnet Mask

— Gateway Address
—MAC Address

— Network FW Version
—Web Remote Version
—IPv6 Address (Local)
‘—IPv6 Address (Global)

X|puaddy

— Paper Size in Tray F—MPTray
—Trayl

—Tray2 ™
HTray3 ™t
HTray4 ™t
—Tray5 ™!

- {System |-—{Serial Number
—Asset Number
—Firmware Version
—1CU Version

—PU Version
—RAM

— Flash Memory
—HDD *°

Date and Time

*1: Displayed when trays 2 to 5 are mounted.

*2: Displayed when using white toner in SP1360W/SP1360S.
*3: Displayed when using clear toner in SP1360S.

*4: Not displayed with SP1360.

*5: Displayed when the built-in HDD is mounted.

*6: Displayed with SP1360W.

*7: Not displayed with SP1360W.
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[Print Information |

— Configuration F100 —{Print
—Network F101 —Print
—Demo Page —{DEMO1 — Print
—File List —Print
—PS Font List —Print
—PCL Font List —Print
—IBM PPR Font List —Print
—EPSON FX Font List —Print
—Usage Report F102 —Print
—|Error Log F103 [—Print
— Color Profile List —Print
—User Media List ** —Print
—Test Print-1 —Print
—Test Print-2 —Print
Test Print-3 ™2 Print
Test Print-4 "3 Print

*1: Displayed when the user media is registered.
*2: Displayed when white toner is used in SP1360S.
*3: Displayed with SP1360W/SP1360S.

[Print Secure Job *! |

Print

Encrypted Job [Ft__—Enter Password }—E Not Found

Delete

Print

Stored Job [F2__—Enter Password }—E Not Found

Delete

*1: Displayed when the built-in HDD is mounted.
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[Menus |

—{Tray Configuration }—{MPTray Config |- Paper Size (A4 [))

— X Dimension 3 (210mm/8.3") F91

—Y Dimension "3 (297mm/11.7") F92
— Media Type (Plain)

— Media Weight (Auto) Fo4

| Tray Usage (Normal Tray) F95

4Tray1 Config Ff Paper Size (Cassette Size) F10

— X Dimension "3 (210mm/8.3")

— Y Dimension "3 (297mm/11.7")

— Media Type (Plain)

— Media Weight (Auto)

— A3Nobi Paper

— Legall4 Paper (Legall4)

— ASLEF/A6/Hagaki Paper (A5 [ )

— A5SEF/Oufuku Hagaki Paper (A5 [J))
- Other Size (B6)

iy

iy

il b e A A W R
N||[N R = (=

{Tray2 Config |- Paper Size (Cassette Size)

— X Dimension "3 (210mm/8.3")

— Y Dimension "3 (297mm/11.7")

— Media Type (Plain)

— Media Weight (Auto)

— A3Nobi Paper

— Legall4 Paper (Legal14)

— A5LEF/A6/Hagaki Paper (A5 [ )

— ASSEF/Oufuku Hagaki Paper (A5 [J)
- Other Size (B6)

'n
N
N

n el itk
w NINININ[N[[N ][N

—Tray3 Config *! |- Paper Size (Cassette Size)

— X Dimension ™ (210mm/8.3")

— Y Dimension "3 (297mm/11.7")

— Media Type (Plain)

— Media Weight (Auto)

— A3Nobi Paper

— Legall4 Paper (Legall4)

— ASLEF/A6/Hagaki Paper (A5 [ )

— A5SEF/Oufuku Hagaki Paper (A5 [J))
- Other Size (B6)

'n
w
-

|
W W|([W|(W]|[W|||W]|||W]||wW

'n
N
o

—Tray4 Config " |- Paper Size (Cassette Size)

— X Dimension "3 (210mm/8.3")
— Y Dimension "3 (297mm/11.7")
— Media Type (Plain)

— Media Weight (Auto) 4
— A3Nobi Paper

— Legall4 Paper (Legal14)
— ASLEF/A6/Hagaki Paper (A5[7 ) 4
— ASSEF/Oufuku Hagaki Paper (A5 [J)
- Other Size (B6)

N

Xipuaddy

N

o ||[m||[m||{m||m|m||m|||m|||m dliedi mdiimdiedikdikdikdiiegd
ul|||u1||u ui|||uf||u|||u|||ua BHlD B Bl
00| N[O ||U1]||B[[|W]||N]|[—]||© O[N] |||u|||[[|L]|[N]][—

—Tray5 Config ™ |- Paper Size (Cassette Size)

— X Dimension *3 (210mm/8.3")

— Y Dimension "3 (297mm/11.7")

— Media Type (Plain)

— Media Weight (Auto)

— A3Nobi Paper

H Legall4 Paper (Legall4)

- ASLEF/A6/Hagaki Paper (A5[7 )

— ASSEF/Oufuku Hagaki Paper (A5 [J)
- Other Size (B6)

vl

_n
w1
O

Paper Feed (Tray1l) F80
Auto Tray Switch (On)

— Tray Sequence (Down)

— Unit of Measurement (mm)

L1 Duplex Last Page (Skip Blank Page)

" Continue to next page
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Y

—System Adjust -—{Power Save Time (1 minute) [F200 |
—Sleep Time (15 minutes) [F201 |
—Auto Power Off Time (4 hours) [F202
— Clearable Warning (ONLINE)
—Auto Continue (Off)

—Manual Timeout (60 seconds)
—Wait Timeout (40 seconds)

—Low Toner (Continue)

—Jam Recovery (On)

Error Report (Off) [F210 |
" /Hex Dump [F237 — Execute \

{Print Adjust F—|Print Position Adjust F—{MPTray [F220 | X Adjust (0.00mm)

Y Adjust (0.00mm)

— Duplex X Adjust (0.00mm)

— Duplex Y Adjust (0.00mm)

— Overprint X Adjust " (0.00mm)

— Overprint Y Adjust "¢ (0.00mm)

'Y Scaling (0.00%)

— Tray1 F221 - X Adjust (0.00mm)

— Y Adjust (0.00mm)

— Duplex X Adjust (0.00mm)

— Duplex Y Adjust (0.00mm)

— Overprint X Adjust "8 (0.00mm)

— Overprint Y Adjust *® (0.00mm)

=Y Scaling (0.00%)

Tray2 2 [F222 || X Adjust (0.00mm)

— Y Adjust (0.00mm)

— Duplex X Adjust (0.00mm)

— Duplex Y Adjust (0.00mm)

— Overprint X Adjust " (0.00mm)

— Overprint Y Adjust "¢ (0.00mm)

LY Scaling (0.00%)

— Tray3 *2 [F223 — X Adjust (0.00mm)

— Y Adjust (0.00mm)

1 Duplex X Adjust (0.00mm)

— Duplex Y Adjust (0.00mm)

— Overprint X Adjust *® (0.00mm)

— Overprint Y Adjust *® (0.00mm)

— Y Scaling (0.00%)

— Tray4 *2 F224 | X Adjust (0.00mm)

— Y Adjust (0.00mm)

>
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— Duplex X Adjust (0.00mm)

— Duplex Y Adjust (0.00mm)

— Overprint X Adjust " (0.00mm)

— Overprint Y Adjust *® (0.00mm)

‘Y Scaling (0.00%)

“{Tray5 *2 F225 |1 X Adjust (0.00mm)

— Y Adjust (0.00mm)

— Duplex X Adjust (0.00mm)

—| Duplex Y Adjust (0.00mm)

— Overprint X Adjust " (0.00mm)

— Overprint Y Adjust 8 (0.00mm)

— Y Scaling (0.00%)

v Continue to next page
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*1:
*2:
*3:
*4:
*5:
*6:
*7:
*8:

Paper Black Setting (0) F230
— Paper Color Setting (0) F231
— Trans. Black Setting (0) F232
— Trans. Color Setting (0) F233
— SMR Setting F234 ] Cyan (0)
— Magenta (0)
— Yellow (0)
— Black (0)
— White 3576 (0)
— Clear "7 (0)
H BG Setting [F235 |- Cyan (0)
— Magenta (0)
— Yellow (0)
— Black (0)
— White 37576 (0)
= Clear "7 (0)
— Drum Cleaning (Off)
- Transfer Roller Cleaning  [F238]— Execute

— High Humid Mode (Off)

— Moisture Control (Off)

Narrow Paper Speed (Slow)

Print Mode (Slow)

Transfer Setting

Cyan Transfer Setting (0)

L{ DV Roller Cleaning

Magenta Transfer Setting (0)

Displayed when trays 2 to 5 are mounted.
Displayed when [Paper size] is set to [Custom].

Yellow Transfer Setting (0)

Black Transfer Setting (0)

White Transfer Setting **>"¢ (0)

Clear Transfer Setting **>*7 (0)

Displayed when white toner is used in SP1360W/SP1360S.

Displayed when clear toner is used in SP1360S.
Not displayed with SP1360.

Displayed with SP1360W.

Not displayed with SP1360W.

Displayed only with SP1360S.
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|Admin Setup

—Network Setup

TCP/IP (Enable)

NetBIOS over TCP (Enable)

EtherTalk (Disable)

IP Address Set (Auto)

IPv4 Address (XXX.XXX.XXX.XXX)

Subnet Mask (XXX.XXX.XXX.XXX)

Gateway Address (XXX.XXX.XXX.XXX)

Web (Enable)

Telnet (Disable)

FTP (Disable)

IPSec (Disable)

SNMP (Enable)

Network Scale (Normal)

Gigabit Network (Disable)

Hub Link Setting (Auto)

Network Factory Defaults

— Execute

—USB Setup

USB (Enable)

Speed (480Mbps)

Soft Reset (Disable)

Serial Number (Enable)

Offline Receive (Disable)

—Print Setup

Personality (Auto)

Copies (1)

Duplex (Off)

Binding (Long Edge)

Job Offset (Off)

Output Bin (Face Down)

Media Check (Enable)

A4/Letter Override (Yes)

Resolution (600dpi)

Toner Save

T Toner Save Level (Off)
Color (All)

Mono-Print Mode (Auto)

Default Orientation (Portrait)

Form Length (64 lines)

Edit Size (Cassette Size)

Trapping (Off)

X Dimension (210mm/8.3")

Y Dimension (297mm/11.7")

—PS Setup }—E Network Protocol (RAW)
USB Protocol (RAW)
PDF Paper Size (Current Tray Size)
—PCL Setup I-{Font Source (Resident?2)

¥ Continue to next page

Font Number (C1)

Font Pitch (10.00CPI)

Font Height (12 point)

Symbol Set (WIN3.1J)

A4 Print Width (78 column)

White Page Skip (Off)

CR Function (CR)

LF Function (LF)

Print Margin (Normal)

True Black (Off)

Pen Width Adjust (Off)

Tray ID#

MPTray (4)

Trayl (1)

Tray2 *! (5)

Tray3 *! (20)

Tray4 "' (21)

Tray5 ™ (22)
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A4

— XPS Setup

DigitalSignature (Off)

DiscardControl (Auto)

MC Mode (On)

Unzip Mode (Speed)

White Page Skip (Off)

—IBM PPR Setup

Character Pitch (10 CPI)

Font Condense (12 CPI to 20 CPI)

Character Set (SET-2)

Symbol Set (IBM-437)

Letter O Style (Disable)

Zero Character (Normal)

Line Pitch (6 LPI)

White Page Skip (Off)

CR Function (CR)

LF Function (LF)

Line Length (80 column)

Form Length (11.7 inch)

TOF Position (0.0 inch)

Left Margin (0.0 inch)

Fit to Letter (Disable)

Text Height (Same)

Continuous Paper Mode (Off)

—EPSON FX Setup

Character Pitch (10 CPI)

Character Set (SET-2)

Symbol Set (IBM-437)

Letter O Style (Disable)

Zero Character (Normal)

Line Pitch (6 LPI)

White Page Skip (Off)

CR Function (CR)

Line Length (80 column)

Form Length (11.7 inch)

TOF Position (0.0 inch)

Left Margin (0.0 inch)

Fit to Letter (Disable)

Text Height (Same)

Continuous Paper Mode (Off)

— Color Setup

Ink Simulation (Off)

—{Panel Setup

UCR (Low)

CMY 100% Density (Disable)

CMYK Conversion (On)

Spot Color *3 (White)

|Near Life Status (Enable)

|Near Life LED (Enable)

11dle Display (Toner Gauge)

[ Panel Brightness During Operating (31)

I Panel Brightness While Power Save (1)

Panel Backlight Timer (30)

—|Front Lamp (Mode1l)

—Time Setup

Date Format (yyyy/mm/dd)

Time Zone (+0:00) *

Daylight Saving (Off)

Time Setting (2000/01/01 00 :00) ™

— Power Setup

Power Save (Enable)

v Continue to next page

Sleep (Enable)

Auto Power Off (Auto Config)
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A4

— Others Setup {RAM Setup }—E Receive Buffer Size (Auto)
Resource Save (Off)
—{Flash Memory Setup **° }—E Initialize — Execute
Resize PS Area —1nn% [n.n MB]
—[HDD Setup "5 I Initialize —1 Execute
—| Resize Partition PCL nn% (20%)
Common mm% (50%)
PS 1% (30%)
<Apply>
— Format Partition (PCL)
[ Erase HDD — Execute
-[Storage Common Setup | Check File System * — Execute
— Check All Sectors "> — Execute
- Enable Initialization (No)
— Security Setup 7 - Job Limitation (Off)
— Make Secure HDD *¢ —1 Execute
— Make Normal HDD *® — Execute
| Reset Cipher Key "¢ —1 Execute
—Language Setup I Language Initialize I Execute
-|[Font Setup |- Font Output Mode (J1S2004) |
#Job Cancel Setup Cancel Key Behavior (Shortt)

Inquiry Display (Long)
Focus Position (Yes)
Display Timeout (180)

—|Settings Reset Settings —1Execute
Save Settings — Execute
Restore Settings ™7 —1 Execute
'{Change Password }—ENew Password
Verify Password

*1: Displayed when trays 2 to 5 are mounted.

*2: Displayed when [Default Edit Size] is set to [Custom].
*3: Not displayed with SP1360/SP1360W.

*4: The time zone and time are set at the factory.

*5: Displayed when [Storage Common Setup] > [Enable Initialization] is set to [Yes].
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*6: Displayed when the HDD is mounted.

*7: Displayed when "Save setup" has been implemented.

[Print Statistics |

-JOB LOG (Enable) |

—{Supplies Report (Disable) |

—Reset Main Counter |—{Execute \

—[Reset Supplies Counter * | —]{Execute |

L[Change Password }—ENew Password
Verify Password

*1: Displayed when [Supplies Report] is set to [Enable].
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|Calibration

—Auto Density Mode (On)
—Auto BG Adjust Mode (0)
r— Density Adjustment Media (Standard Media)

—Adjust Density F300 —Execute
r—Adjust Registration F301 —Execute

HHeavy Media Adjust (Off)
—Heavy Media Mode (Auto)
+—Color Density —{Cyan Density (0) [F310 |
HMagenta Density (0) [F311 |
—Yellow Density (0) [F312 |
—Black Density (0) [F313 |
HWhite Density " *3"4 (0) [F314

— Clear Density 2"3*> (0) [F314 |
L|Print Color Tuning Pattern  [F302 |{Execute

{Base Color Tuning }-{Highlight (A-1)
—Mid-Tone (A-1)
—Dark (A-1)
—[Fine Color Tuning {Cyan Tuning |- Highlight (0)
— Mid-Tone (0)
— Dark (0)
{Magenta Tuning |- Highlight (0)
— Mid-Tone (0)
— Dark (0)
—Yellow Tuning I Highlight (0)
— Mid-Tone (0)
— Dark (0)
Black Tuning I Highlight (0)
— Mid-Tone (0)
— Dark (0)
{Reset Color Tuning | Execute \
—White Tuning "1 "3 Highlight (0)
Mid-Tone (0)
Dark (0)
*1: Displayed when using white toner in SP1360W/SP1360S.
*2: Displayed when using clear toner in SP1360S. zZ
*3: Not displayed with SP1360/SP1360W. §
%
[Boot Menu |
Network Factory Defaults —Execute
HDD Setup ™ —Enable HDD (Yes)
Storage Common Setup ™! —[Check File System —Execute
Check All Sectors —Execute

Menu Lockout (Off)
Panel Lockout (Off)

*: Displayed when the power supply is turned ON while the [OK] button is being pressed.
Boot Menu is displayed in English only.
*1: Displayed when the HDD is mounted.
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Basic Windows Functions

This section explains the procedures for displaying the drivers setup window from the [Printers]/[Printer
and Fax] folder for OS other than Windows 7, which is used as an example in this manual.

® The Windows Server 2008 R2 procedure is the same as for Windows 7.

@ If installing multiple drivers, the icon will be displayed for each driver in the [Printers]/[Printer and Fax] folder. Use the
following procedure for the drivers to be set up and checked.

Displaying the Properties Displaying the print setup
Window window

® Windows 8.1/Windows 8/ ® Windows 8.1/Windows 8/
Windows Server 2012 R2/ Windows Server 2012 R2/
Windows Server 2012 Windows Server 2012

1 Click [Setup], and select [Control 1 Click [Setup], and select [Control

panel]> [Show devices and printers]. panel]> [Show devices and printers].

2 Right-click the IntoPrint SP1360 icon, 2 Right-click the IntoPrint SP1360 icon,

and select [Printing Preferences]. and select [Printing Preferences].

B Windows Vista/Windows Server B Windows Vista/Windows Server
2008 2008

1 Click the [Start] button, and select 1 Click the [Start] button, and select

[Control panel]> [Printers]. [Control panel]> [Printers].

2 Right-click the IntoPrint SP1360 icon, 2 Right-click the IntoPrint SP1360 icon,
and select [Preferences]. and select [Printing preferences].
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Specifications

Main specifications

Model Number SP1360: N36100A(120V),
SP1360W/SP1360S: N36101A(120V),

CPU SP1360/SP1360W/SP1360S: ARM Processor (1.2GHz)

RAM (standard/ 2GB/2GB

max.)

Weight SP1360: Approx. 82kg (not including consumables)™
SP1360W/SP1360S: Approx. 91kg (not including consumables)™

Power 110 to 127 VAC (Range 99 to 140 VAC), 50/60 Hz = 2%

Power consumption |[During operations: 1,600W max./Average 1,100W

During standby:  Average 40W

In power save mode
In power save mode: 30W max.
In sleep mode: 4W max. (factory settings)
In Auto Power OFF:  0.4W max.
* The product does not consume power when the main power switch is OFF, even if the power plug is
inserted into the outlet.

Use environment Temperature 10°C to 32°C, humidity 20% to 80%RH
conditions Max. wet bulb temperature 25°C (Environments where high-quality and full color are
assured : Temperature 17°C to 27°C, humidity 50% to 70%RH)

Network connection [1000BASE-T/100BASE-TX/10BASE-T (Factor y settings 100BASE-TX/10BASE-T)
Local connections USB2.0 interface (Hi-Speed USB supported)
Display 4.3" high-resolution color LCD (480x272dots)

Compatible OS Windows 8.1//Windows 8/Windows 7/Windows Vista/Windows Server 2012 R2/Windows
Server 2012

Windows Server 2008 R2/Windows Server 2008

Mac OS X 10.3.9 to 10.10

For details, see the operations environment.

Print method SP1360: Dry electronic photo method using 4 continuous digital LED heads
SP1360W/SP1360S: Dry electronic photo method using 5 continuous digital LED heads
Resolution | Print 1200 x 1200dpi (2 shades) / 1200 x 600dpi (16 shades) / 600 x 600dpi (2 shades) é’
resolution g
LED dot pitch | 1200dpi 5
Print colors Yellow, magenta, cyan, black, white"?, clear™
Print languages PostScript3, PCL6 (PCLXL3.0, PCL5c), PDF1.7, XPS, IBM PPR, EPSON FX
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Specifications

SP1360 | spi3e0 | spPizeow
Print Color CMYK 50 pages/min. (A4 landscape feed), 28 pages/min. (A3 portrait feed)
speed™ | (1-sided) (If auto paper weight is set)
CMYK+Spot Color CMYK+Spot CMYK+Spot
Color white: Color white:
45 pages/min. |45 pages/min.
(A4 landscape |[(A4 landscape
feed), feed),
25 pages/min. |25 pages/min.
- (A3 portrait (A3 portrait
feed) feed)
CMYK+Spot
Color clear:
18 pages/min.
(A4 landscape
feed)
Spot Color overprint™ 16 pages/min.
(CMYK+Spot Color white) (A4 landscape
_ feed) ;
6 pages/min.
(A3 portrait
feed)
Monochrome (1-sided) 50 pages/min. (A4 landscape feed)
28 pages/min. (A3 portrait feed)
(If auto paper weight is set)
Auto CMYK Color: 50 pages/min. (A4 landscape feed)
Duplex Monochrome: 50 pages/min. (A4 landscape feed)
Color: 28 pages/min. (A3 portrait feed)
Monochrome: 28 pages/min. (A3 portrait feed)
(If auto paper weight is set)
Spot Color white (Single 45 pages/min.
Color only)™® ) (A4 landscape feed),
25 pages/min.
(A3 portrait feed)
Spot Color overprint _
(CMYK+Spot Color white)
Type of  |Paper Plain, thick paper (glossy, transparent film™, transparencies™°, postcards, labels™*,
paper”’ |quality™® envelopes™?)
Paper size A3NOBI, 13x18", ABWIDE (SRA3), A3, AAWIDE (SRA4), A4, A5, A6, B4, B5, B6, letter,
legal13/13.5/14, Executive,
Statement™?, Tabloid Extra, Tabloid, 8K, 16K, envelopes™, postcards,
Japanese double postcards, 4-REN Hagaki, index cards™*?, B6 half'*?, custom™®
GSM paper |1sttray: GSM 52 to 320g/m? (ream weight 45 to 275kg)
weight Expansion tray unit: GSM 52 to 320g/m’ (ream weight 45 to 275kg)
Large-capacity expansion tray unit: GSM 52 to 320g/m? (ream weight 45 to 275kg)
Multi-Purpose Tray: GSM 52 to 360g/m? (ream weight 45 to 309kg)
Auto Paper size A3NOBI, 13x18", ABWIDE (SRA3), A3, AAWIDE (SRA4), A4, A5, A6 portrait feed, B4,
Duplex B5, B6, letters, legal13/13.5/14), Executive,
Functions Statement, Tabloid Extra, Tabloid, 8K, 16K, postcards, Japanese double postcards,
4-REN Hagaki, Custom™®
GSM paper |1st tray: GSM 64 to 320g/m? (ream weight 55 to 275kg)
weight Expansion tray unit: GSM 64 to 320g/m’ (ream weight 55 to 275kg)

Large-capacity expansion tray unit: GSM 64 to 320g/m” (ream weight 55 to 275kg)

Multi-Purpose Tray: GSM 64 to 320g/m?* (ream weight 5

5 to 275Kkg)
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Paper Multi-purpose | Capacity 310 sheets (GSM weight 64g/m?, total thickness 31mm max.)""’

feed tray
E:atdhOd/ 1st tray Capacity 580 sheets (GSM weight 64g/m?, total thickness 53mm max.) 8
quantity |Expansion (Optional) Capacity 580 sheets (GSM weight 64g/m?, total thickness 53mm max.) "
tray unit
Large-capacity | (Optional) Capacity 580 sheets x 3 trays (GSM weight 64g/m?, total thickness 53mm
expansion max.)
tray unit
Paper feed | Face down 620 sheets max. (GSM weight 64g/m?)
method/  [race up 300 sheets max. (GSM weight 64g/m?)
Output
capacity
Assured print range 6.35mm from the paper edge (excluding special paper such as envelopes, etc.)
Print accuracy Write position accuracy £2mm; paper slant: £1mm/100mm
Image expansion and contraction £1mm/100mm (GSM weight 80g/m?)
Warm-up time Approx. 50s (max.) after power is turned ON (At room temperature 25°C and rated

voltage)™®

Average print quantity |[25,000 sheets/month

Use environment Temperature 10°C to 32°C, humidity 20% to 80%RH, max. wet bulb temperature 25°C
conditions (Environments where high-quality and full color are assured : Temperature 17°C to

27°C, humidity 50% to 70%RH)

Consumables and Consumables, toner cartridge, image drum,
maintenance products [maintenance products, fixer unit, transfer roller unit, belt unit, paper feed roller set,

waste toner box

Device service life"* 5 years or 1.5 million pages

*1:
*2:
*3:
*4:

*5:

*6:
*7:

*8:

*9:

*10:
*11:
*12:
*13:
*14:

*15:

*16:

*17:
*18:
*19:
*20:
*21:
*22:

The total weight including consumables is approx. 98kg.
The total weight including consumables is approx. 111kg.
SP1360S specifications only.

Plain paper, in copy mode print speed is slower for postcards, envelopes, and card stock. Operation may slow down during
continuous printing due to adjustments in machine temperature and image quality.

The mode that prints white before CMYK. If the paper size exceeds B4, the print speed is slower. The lifespan of the image
drum or maintenance parts will become less than half.

Compatible with plain and glossy paper only.

Print quality and paper traction may suffer depending on the paper used and the use environment. Implementing a test print
beforehand is recommended. Consult your supervisor if anything is unclear.

For glossy, coated and embossed paper, thoroughly test the print quality and paper traction beforehand, and check that there
are no impediments before use.

Xipuaddy

Compatible with Multi-Purpose Tray only.

Compatible with 1st tray and Multi-Purpose Tray only.

Compatible with A4 and letter only.

Compatible with Multi-Purpose Tray only. The paper may curl or crease after printing.
Compatible with Multi-Purpose Tray only.

Nagagata #3, Nagagata #4, Nagagata #40, Yougata #0, Yougata #2, Yougata #4, Younaga #3, Kakugata #2, Kakugata #3,
Kakugata #6, Kakugata #8, C4, C5, DL, COM-6 3/4, COM-9, COM-10, Monarch, A2 Envelope, A6 Envelope, A7 Envelope.

1st tray, expansion tray unit, large-capacity expansion tray unit: Width 100 to 330mm x length 148 to 457mm.
Multi-Purpose Tray: Width 64 to 330mm x length 90 to 1,321mm. If using Spot Color overprint, length is 182 to 457mm.

1st tray, expansion tray unit, large-capacity expansion tray unit: Width 100 to 330mm x length 148 to 457mm.
Multi-Purpose Tray: Width 64 to 330mm x length 90 to 483mm.

Postcards x 110, tra sparencies x 200, envelopes x 40 (GSM weight 85g/m?).
Postcards x 210, transparencies x 360.

Postcards x 210.

Does not include compensation operations.

Device service life depends on the customer's use conditions.
SP1360W/SP1360S specifications only.
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Specifications

Network interface specifications

® Basic specifications
Network protocols

® For TCP/IP
® For EtherTalk

® Connectors
1000BASE-T / 100 BASE-TX / 10 BASE-T (Auto switching and simultaneous use are not possible)

C! Note)

® The default factory setting is to disable 1000BASE-T.
If using with 1000BASE-T, use the control panel to make the following settings.
Set to [Administrator menu]> [Enter password> [Network Setup]> Gigabit Network]> [Enable].

® Cables
Unshielded twist pair cable with EJ-45 connector (category 5e or later)

® Connector pin array

1 8
| |

® Interface signals

Pin | Signal Function
name

TRD+(0) |Data 0 sending and receiving (+)
TRD-(0) |Data 0 sending and receiving (-)
TRD+(1) |Data 1 sending and receiving (+)
TRD+(2) |Data 2 sending and receiving (+)
TRD-(2) |Data 2 sending and receiving (-)
TRD-(1) |Data 1 sending and receiving (-)
TRD+(3) |Data 3 sending and receiving (+)
TRD-(3) |Data 3 sending and receiving (-)

OO\ICDU'I-war—Ag

>
i=]
o
[0)
=
o
x
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Specifications

USB interface specifications

® Basic specifications
USB (supports Hi-Speed USB)

® Connectors
B receptacle (female) upstream port

® Cables

5m max. USB2.0 specifications cable (2m max. recommended)
(Do not use shielded cable wires.)

® Send mode

Full speed (12Mbps+0.25% max.)

High speed (480Mbps+0.05% max.)

® Power control
Self-powered device

® Connector pin array

® Interface signals

Signal Function
name
1 Vbus Power supply
(+5Vv)
2 D- For data transfer
3 D+ For data transfer
4 GND Signal ground
Shell Shield

X|puaddy
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Specifications
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10-Key Pad ...ccviieiiiiiiii i e 22

2-sided documents .......ccoeviiiiiii 19
A
Adjusting brightness ..........ccocoiiiiiennnnn. 24, 25
Errors v 28
Air holes. ..o 34
AUEO Lo 89
Auto Power OFF Mode
SetUPD . i 112
Switching Time........ccooiiiiiiie 113
B
Back button ... 24
Belt unit lever ... 20
Belt unit lock lever......c.coiiiiiiiie, 20
BONJOUN ...t 68, 72
Built-in HDD ....cccovviieieienene 24, 25, 26, 48, 76
BULLON e e 21, 22
C
Cable connections.......ccooviiiiiiciiiis 57
[CANCEL] button .....ccvoviviiiiiiiiineeaens 24, 116
Cancelling ..o 31, 116
SIOt e 24
Cancelling OFF mode .......cooiviiiiiiiiiiiiiieeans 31
Card authentication ..........ccoviiiiiinnn 24, 27
Carrying handles ........cooiiiiiiiiiiiic i 19, 23
Carrying lever....ccoviiiiiiiiic i 18, 19
[CLEAR] KeY euieiiiiie i 18
color management server...............u. 18, 19, 22
Consumables ... 39
Toner cartridge......oovvevieiiiiiiiieieeenne 39
Consumption POWEr .....ccviiiiiiiiiii e 50
Control panel ... 21
Customer SUPPOrt.....ccvvviiieiiiiriiie e 18
Customization .......coviiiiiii i 93, 94

D
Detecting Automatically.........ccooviiiiinnnnen. 88
(D)1 0 g 1=T 0 Y o] 1= P 134
DoCUMENES oo e 18
Driver installation ..., 55
MaC OS X it i i e 68
WINAOWS oot 59

E
ENVEIOPES. . .viiiii i 19
Environment conditions .........ccooviiiiiiiiennnnnn 56
EPS data ...covviiiiiiiiii i 56
= o] g =T ol g 1= o 27
EtherTalk...coooviiriiii e 68, 69
Exit Unit knob .....coovviiiiiii 19, 22
Expansion tray unit.........cc.ooeviiiiiiinnnnnnn 44,76
Setup (Mac OS X) vvvvvviiiiiiiieiieeineneeas 79
Setup (Windows) ....ocvviviieiiiiiniinenenss 76
Expansion tray unit with casters.............. 29, 45

F
Face-down Stacker ........covvivviiiiniinnnnnn. 22,101
Face-up Stacker ... 103
Factory settings........covvviiiiii i 29, 60
[FN] KeY oo e 24, 29
Front lamp.. e 18
Function number input screen .............oooeuel. 30
Fuser Unit ..o e 22
Fuser Unit's Jam Release Lever..................... 22

G
Gateway address....covvviiiiiiiiii i 59

H
Handle ..o 24
[HELP] button ....cvviviiiiiiiiiicie e 24, 27
Help SCreen ..o 20
HUDS . oo 57
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Image drum ... 19
Job list v 17, 20
Product warranty, supplying free

maintenance, and customer support....20

1] 0] ] 01T g 39
Toner cartridge.....oovvvviiiiiiiiiinennns 17, 20
Installation .....ccoovviiiiiii 33
Installation environment..................... 33
Installation procedure .........cccvvvvvvinnnnn. 36
Installation space .......coovveiiiiiiiiennnnn. 33
Relocation......c.covviiiii i 36
Interface
Network interface connector................. 19
IP @ddress . coviiiiii i 59, 62
J
Japanese double postcard........cccvviiiiiiiiiinnnn. 27
L
LAN (network interface connector)................ 23
LAN cable ..o 57
Connecting ..cccvvviiiiiii i 57
Large-capacity expansion tray unit.......... 26, 45
(=] BN =1 1 0¥ o T 51, 52
Liquid crystal panel.........cooooviiiiiiinnnns 18, 19
Lock lever Knob......ccvieiiiiiicii e 20
LPD Protocols (TCP/IP) ....cciieiiiiiiieiieiene 117

M
Mac OS X printer driver
Documents .....c.oooviiiiiiii i 24
Main power switch...........coooiiennee, 18, 51, 52
Power conditions ..........coovieiiiiiiininenne. 19
MainteNanCe .....cvviiiiiii 2
Manual Feed Printing (Multi-Purpose Tray) ..... 96
Menu button
[OK] button ..ovvvviiiiiiiieica, 24, 25
Scroll button ... 24
MeNU IteMS...ii i 27
Menu items table........c.oooiiiii 119
MESSAQGES ..uviiiiiiiii i 18
Mounting options
BUilt-in HDD....ovvv i 48
Expansion tray unit............ooeeeiiiiinen . 44
MP Paper Guide.....c.iviviiiiiiiii i i 21, 95
Multi-Purpose Tray......cvvvivnnnnn 24, 93, 94, 96
N
NEEWOIK ..o 31
Cables.. . 57
SUPD et 63
Network connection
Cannotset up vvvvviiiiiiiiiieiee 68, 76
Setting up (Mac OS X)..oiviviiiiiiiiiiiinnnnns 68
Setting up (Windows)......ccovvvviiiiiiinnnnns 59
(o)
OFF mode
Customization ......covvviiiiiiii e 24
Power save mode .........cooeviiiiiiiininennn. 24
Sleep MOde .oviviiiii i 18
[OK] button ... 24, 27
Operating environment.........cooieiiiiie e, 22
Operating methods...........ccooviiinnin 18, 24, 25
Output rail unit ... 22
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P
PaP e e 81
OULPUL o e 101
Settings cvvvviiii 88, 94
SIZE e 82
ThiCKNess ..o 82
YD ettt e 82
Usable Paper......ccooiviiiiiiiiiiic i 81
Paper Cassette......ccoovvviiiiiiiinnnnne, 21,43, 88
Paper Feed Orientation...........cooiiiiiiiiinnnnn. 87
Paper Size......oovvviiiiiiii 18
Paper Size
StUPD . it e 93
Paper tray .o 22
P e 3
P i e 56
PCs
Connecting to the device ............... 55, 57
Connecting using LAN cable ................. 57
Connecting using USB cable................. 58
Setting IP addresses .......cccvvvvvviiiiinnnn. 62
Postcards ......oovviiiiii i 20
PostScript fonts....cooeiiiiiiii 56
Power cable ..o 51
Power save
Power save mode ........cociieiiiiiiininnnn. 105
[POWER SAVE] button
Power save K&y .....ovveviiiiiiiiiiii i 27
Power save mode .......coevvviiiivninnnns 24, 27
Power save mode .....vvviiviviviiiieniiiineeenns 24, 25
SetUP . i 105
Power supply «cvvvviiiiiiii e 50
OFF i e 52
ON o e 51
Power supply conditions.................o.uee. 50
Power switch.......coooiviiiiiiiic, 19, 51, 52
Main power switch ........ccviviiniinnnns 51, 52
Preparations .....ovviiii e 19
Printer driver ... 18
Printer drivers
WINAOWS ..o 128

Printer DrivVers ....ovvvvviviiiie i ennns 55, 89, 96

Expansion tray (optional)...............c....e. 76
MaC OS X e e 68
TYPES c ittt 56
WINAOWS ..o 59
Printer information ..........ccooviiiiiinn . 53, 54
Printing ... 21,81
Cancelling.....cooveeiiiiiii e 116
Manual Feed Printing...........cccoeevvinennne. 99
Paper supporter.........cooeviiiiinenninns 21, 22
Printer information.............cccevvvens 53, 54
Test Prints oo e 53
Upper right side cover.........c.oovvinennnn. 21
Problems...cccoviiiiii 68, 76
P S 56
R
Relocation ..o 36
Remaining toner quantity display.................. 18
RENAEZVOUS .vvvvv it i nieee e 68, 72




Securing lever... .o 17, 20
Setting optional drivers

= Tol @ S 79
WINAOWS ..o 76
SetUP wii i 33
Network connection ..........ccevvvvinnns 59, 68
Toner cartridge......oooviiiiiiiiiii i 39
USB connections........ccvvvvvviininnnn. 66, 74
ShUutdOWN ... e 52
Sleep mode
Disabling ..ooviieiiii 69
Restrictions.....ccvvviiiiiiiie 110
SetUPD . i 107
Switching Time......c.ooooiiiie 108
SIOt e 17, 20
Printing ..o 20
Specifications......coooiiiiiiii 129
DimensionS.....cvviviiiiii i 134
Network interface ...........coeviiiiininnnn. 132
USB interface.......cocovveviiiiiiiiiiinninnn 133
Standby sCreen ... 17
Starter toner cartridge .......c.covvieiieinnnn. 24, 25
Startup SCreen ..o 32
Subnet mask ....ccvviiiiii 59, 61
T

Test prints

Test printing using the printer alone...... 53
Toner cartridge....ccovviiiiiii 39
Toner replacement Cover .......ccovvvviinvnnnnns 17, 20
Transfer Roller Unit.................... 17, 22, 41, 42
Transfer Roller Unit’s Lock Leve .............. 22,42
Tray information display ......cocovvviiiiiinnnnns 18
TrAY St e 24, 25, 26

Tray 1o 18, 43, 88

Trays 2/3/4/5..ccciiiiiiiiiiinns 43, 45, 88
Troubleshooting.......cccovviiiii i 2
Turning OFF the power automatically...... 52, 112

U
Upper left side cover......ccoviiiiiiiiiiiii i 20
USB cable....oiiiiiiiii i e 58
Connecting ...vvvvvvviiiii e 57, 58
USB connections
Cannotset up cvvvviiiiiiiiiie e 68, 76
Setting up (Mac OS X).ovvviiviiiiiiiiniinnnnns 74
Setting up (Windows)......ccovvvviiiiiiinnnnns 66
USB interface connector .........ccovvvvieiiininnnnnn. 58
USB POt o e 58
US ottt e e 24
ATTENTION [@amp ceoeiiiiiiiiii e 29
Power cable .....cccoviviiiiii 24
Utility software......ccooviiiiiiiiiiiici e 2,3
W
Weight .o 36
Weight (Mass) .ooviieiii i 17
WiINAOWS ..o 19, 23
X
XS e 56
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Contact Us

www.IntoPrint.com

800-833-4493

PO Box 7428

Roanoke, Virginia 24019

Headquarters:

1214 Trapper Circle NW

Roanoke, Virginia 24012
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